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1 GEOSS Introduction (same for all tutorials) 

This tutorial is published as a documentation resource for the Global Earth Observation 
System of Systems (GEOSS).  The purpose of this tutorial is to assist the GEOSS 
providers and GEOSS users in understanding the various ways in which GEOSS can be 
used to provision, discover, access, and use Earth observation data and services.  The 
contents of this tutorial are provided, for the common good, under the Creative 
Commons Attribution 3.0 Unported License.  This license is referenced at the bottom of 
the page, and applies to the entire tutorial.  Briefly, the Creative Commons License 
allows the copying and sharing of this content, as long as proper attribution is made.  
Proper attribution shall include the list of authors (shown in the Tutorial Author table 
below) and the fact that the tutorial is for the benefit of the GEOSS.  An example 
attribution is: "The GEOSS MyService Tutorial authored by Author 1, Author 2, etc., 
available from the GEOSS Best Practices Wiki.", where MyService is replaced by the 
actual name of the tutorial being reused or shared. 

Any material that appears directly in any section of this tutorial that originated in a 
different work will be annotated with a reference identifier.  This reference identifier 
can be found in the Bibliography section of the tutorial, along with the details of the 
reference.  This bibliographic reference will serve as attribution for the material.  It can 
be inferred from the existence of this attribution that the material being referenced and 
attributed is either in the public domain, offered through a license such as Creative 
Commons Zero or Creative Commons with Attribution, or has been used under explicit 
permission from the copyright owner of the material. 

This tutorial can be found directly at the GEOSS Best Practices Wiki (BPW) 
(http://wiki.ieee-earth.org).  It can also be found indirectly via a search at the Geo Web 
Portal (GWP)(http://www.geoportal.org).  If registered at the BPW, and logged in, a 
reader of this tutorial can post comments on each page of the tutorial.  These comments 
can serve to point out ways in which this tutorial can be improved upon. 

 

1.1 Overview of GEOSS 
The Global Earth Observation System of Systems will provide decision-support tools to 
a wide variety of users. As with the Internet, GEOSS will be a global and flexible 
network of content providers allowing decision makers to access an extraordinary range 
of information at their desk.  
This ‘system of systems’ will proactively link together existing and planned observing 



systems around the world and support the development of new systems where gaps 
currently exist. It will promote common technical standards so that data from the 
thousands of different instruments can be combined into coherent data sets. The 
‘GEOPortal’ offers a single Internet access point for users seeking data, imagery and 
analytical software packages relevant to all parts of the globe. It connects users to 
existing data bases and portals and provides reliable, up-to-date and user friendly 
information – vital for the work of decision makers, planners and emergency managers. 
For users with limited or no access to the Internet, similar information is available via 
the ‘GEONETCast’ network of telecommunication satellites. 
The Global Earth Observation System of Systems is simultaneously addressing nine 
areas of critical importance to people and society. It aims to empower the international 
community to protect itself against natural and human-induced disasters, understand the 
environmental sources of health hazards, manage energy resources, respond to climate 
change and its impacts, safeguard water resources, improve weather forecasts, manage 
ecosystems, promote sustainable agriculture and conserve biodiversity. GEOSS 
coordinates a multitude of complex and interrelated issues simultaneously. This cross-
cutting approach avoids unnecessary duplication, encourages synergies between 
systems and ensures substantial economic, societal and environmental benefits. 

1.2 Explanation of tutorials, in general 
The AIP-4 tutorials aid data providers in deploying synchronous on-line access for their 
data. This activity was done in coordination with the Standards and Interoperability 
Forum (SIF), which managed the outline of tutorial topics. Data Access procedures, as 
recommended by the DSTF and GCI CT, were followed in AIP-4. An emphasis was 
placed on planning for multi-year persistence of the online data access and also on 
software, techniques and standards that make this possible. 

2 Introduction to the topic 
This chapter establishes the background information of web feature system 
interoperability, and the OpenGIS® WFS Standard. 
 
How do the resources and the developed WFS service contribute to the GEOSS? 
How to follow this tutorial in order to publish other Earth Observation data through 
WFS interface? 
Things needed to be considered when providing robust WFS interface in an operation 
environment. 
How to use the example data for GEOSS SBA application? 
 

2.1 Discussion of the tutorial use 
This chapter presents the technologies and the tools for WFS client and server 
development. WFS standard, version 2.0, is directly referenced to the corresponding 
"WFS requests" specification sections (GetCapabilities, DescribeFeature, GetFeature, 
etc) regarding the information needed when implementing the WFS interface. 
 
Furthermore, this chapter also explains how to work with GML, and the concept of a 
GML application schema. It also shows you how to design your feature types by using 
UML class modeling, and how to convert it automatically to a GML application schema 



by using ShapeChange application (a java application that takes a UML model in XMI 
and converts it to a GML application schema). 
 
This tutorial provides the necessary information for a data provider to publish its vector 
data though a WFS server. Some examples, illustrated with real data, are presented in a 
step by step description with open source and proprietary server technologies. 
Hopefully, these examples can be easily adapted to the provider data particularities. In 
addition, this tutorial presents some information regarding the WFS standard and its 
operation. This is illustrated with examples, which can be used by a technology 
developer as an easy way to have a first contact with a particular specification, before 
reading the hard details of the standard document itself. It is also thought to be used by 
teachers that want to present the WFS standard to their pupils using existing examples. 
A WFS user is supposed to access the data, to download the data, and to use 
visualization tools, some examples of these practices can also be seen here. 
 

2.2 How interoperability is improved through the use of this 
server/service 

2.2.1 Sharing features interoperability problems  
A geographic feature is an abstraction of a real world phenomenon that is associated 
with a location relative to the Earth. A digital representation of the real world can be 
thought of as a set of features. A feature is a container for a set of values that 
characterizes that particular feature. Feature values are formalized in sets of properties 
where each property can be thought of as a {name, type, value} triplet. 
Real world features are classified into feature types which can be characterized by a set 
of common properties. The number of properties a feature may have, together with their 
names and types, are determined by the feature type definition. Geographic features 
with geometry are those who have at least one geometric type property and one 
geometric value. 

2.2.1.1 Sharing data model problem 
Fortunately, many features of the real world can be classified into a single feature type 
and thus share the same set of property names and types. The process of choosing and 
defining feature types that build a feature collection are called data model definition. 
 
Currently, almost each GIS software vendor has its own data encoding. In many GIS 
softwares, the definition of the data model starts by distributing the different feature 
types into different layers. Each layer can only contain a particular feature type with a 
particular kind of geometry (e.g. point, line or polygon) and defines a table of attributes 
that a feature can have. One of the most common formats that use this approach is the 
shape file, which can only contain a feature type with its associated geometric property 
in a binary file (.shp); the non geometric attributes will be contained in a table file (.dbf) 
as well as in a data indexing file (.shx). In this approach, the way features are going to 
be visualized (symbolized) is not included in the data model and it is left at the user 
discretion. 
In this case, the data model is described by the number of layers, the use of points, lines, 
polygons etc, and by the data table field type's definition. 
 



On the other hand, many CAD software vendors use another approach. Even though the 
feature types are also classified into layers, now the properties are represented by 
symbolization properties like colors, line width, line style, etc. Commonly, all feature 
types are stored in a single file (such as .dxf or .dgn).  
In this case, the data model is described in a separated document where layering and 
symbolization are related to feature attribute types. 
 
Other models are also possible, such as the geodatabase model where features are 
associated to records from tables from a database. Each feature type can be recorded in 
a different table and each property is stored with a date field. Spatial data can be both 
stored in a specific kind of data fields (geospatial fields) or as a sequence of coordinates 
in separate tables (in numerical fields). 
 
In this heterogeneous situation, there is a need for a unified feature type definition and 
encoding. There is also the need for a data service that could inform and communicate 
the feature type’s definition. The WFS services define the DescribeFeature operation as 
a way to request feature types, and these can be shared using GML application schemas. 

2.2.1.2 Sharing feature collection problem 
A feature collection is a sequence of different types of features. In the scenarios 
previously described, feature collections can be expressed in different data formats by 
different software vendors. Fortunately, features can be stored in files which in turn can 
be redistributed by web accessible folders or by ftp. For example, the Circum-Arctic 
Map of Permafrost and Ground-Ice Conditions (http://nsidc.org/data/ggd318.html) can 
be accessed by ftp via 
ftp://sidads.colorado.edu/pub/DATASETS/fgdc/ggd318_map_circumarctic in 
shapefiles. 
 
Nevertheless, this approach does not offer the user the possibility to control the data 
format used, and it is completely up to the producers who offer their own favorite 
format and in some cases other popular formats. This usually leads to the coexistence of 
several different incompatible data formats. Furthermore, some geospatial information 
can generate large files which can be difficult to transmit. Therefore, to be able to 
extract only a subset of elements from the original file would be an asset. 
 
In this heterogeneous situation, it is detected that a common way to request a subset of a 
feature data from some feature types is needed. Therefore, the WFS services define the 
GetFeature operation as a way to request subsets of feature collections, being the 
features shared in GML encoded files. 
 

2.2.1.3 Editing a feature collection problem 
Feature collections aren’t static. Sometimes, the representation of a feature is not 
accurate enough, and later, a better representation becomes available; or sometimes the 
real world changes and their feature representations have to be updated accordingly. In 
our previous example, where data was held in web accessible folders or by an ftp file, 
the simplest approach would be to update the dataset and replace the whole file with the 
updated version. This is only possible when the changes are made in a centralized way, 
where there is only one person responsible for the management of the dataset to be 
updated. In other cases, different independent actors maintain a single dataset from 



different places. In the worse scenario, each actor could use a different format and a 
different set of tools to do it.  
 
When a decentralized and heterogeneous situation occurs, the need for a common way 
to sent updates of some features, while keeping the majority of them intact is of great 
importance. The WFS services define the Transaction operation in order to create, 
update or delete some features in a feature collection; it also uses GML encoded files to 
communicate which features are being affected by the operation. 
 

2.2.2 Data modeling needs and GML 

2.2.2.1 Formal definition of a data model is possible only when the changes are 
made in a centralized way 
The main format used in WFS is GML. GML requires a clear definition of the data 
model, as previously mentioned, it specifies the feature types and their properties. In 
this section of the tutorial we are going to use a very simple layer defining the position 
of 4 different pole locations that we have extracted from the "Atlas of the Cryosphere" 
web site (CSR record: 
https://geossregistries.info/geosspub/component_details_ns.jsp?compId=urn:uuid:07fda
5dd-00a9-4c25-9668-dc598ca73fd7). The portal has the functionality of saving the data 
for a later use, and thus one can retrieve the desired layer in Shapefile or in GML 
format. 
 

 
 
The shapefile format is downloaded in a ZIP file. The ZIP file contains 5 files. 
 



 
As a classical GIS file, a shapefile is geospatial-centric which means that entities are 
encoded as point files whose positions are being binary encoded in a .shp file.  

 
 
These points are linked to a separate table file that contains alphanumeric attributes in a 
.dbf file. 
 

 
 
The shapefile is implicitly defining a data model. In this example, there is only one 
feature type, let’s call it PoleLocationType. This type has 3 properties: one geometric 
property and two thematic properties. The geometric one is expressed by a point 
coordinate, and the thematic ones are represented as a number (Id) and as a name 
(description). 
 
A GML file is a text file that can be seen in an XML editor (such as XMLSpy). This 
tutorial assumes that you are familiar with XML; if this is not the case, we recommend 
you to get started with the course available in the W3C school tutorial at 
http://www.w3schools.com/xml/default.asp.  
 



This is how the position of the Geographic North Pole is expressed in GML.  
 
 
 <ogr:PoleLocation fid="F0"> 
  <ogr:geometryProperty> 
   <gml:Point> 
    <gml:coordinates>0,0</gml:coordinates> 
   </gml:Point> 
  </ogr:geometryProperty> 
  <ogr:id>0</ogr:id> 
  <ogr:name>Geographic North Pole</ogr:name> 
 </ogr: PoleLocation > 
 
In GML format, objects are represented in upper camel case (all words start by a capital 
letter) and properties in lower camel case (all words start by a capital letter except the 
first one). Objects are composed by property elements, which in turn can be described 
by objects. So that, GML alternates objects and properties and this is clearly identifiable 
by the alternated use of upper camel cases and lower camel cases (the original GML file 
does not follow this notation and thus, it has been altered in this example). 
 
A very common way of encoding a complete GML file is to pack features into feature 
collections. A feature collection is a list of features. This XML fragment shows the 
whole feature collection. 
 
<ogr:FeatureCollection> 
 <gml:featureMember> 
  <ogr:PoleLocation fid="F0"> 
   […] 
   <ogr:name>Geographic North Pole</ogr:name> 
  </ogr:PoleLocation> 
 </gml:featureMember> 
 <gml:featureMember> 
  <ogr:PoleLocation fid="F1"> 
   […] 
  <ogr:name>Magnetic North Pole (2005)</ogr:name> 
  </ogr:PoleLocation> 
 </gml:featureMember> 
 <gml:featureMember> 
  <ogr:PoleLocation fid="F2"> 
   […] 
  <ogr:name> Geomagnetic North Pole (2005)</ogr:name> 
  </ogr:PoleLocation> 
 </gml:featureMember> 
 <gml:featureMember> 
  <ogr:PoleLocation fid="F3"> 
   […] 
  <ogr:name>North Pole of Inaccessibility</ogr:name> 
  </ogr:PoleLocation> 
 </gml:featureMember> 
 <gml:featureMember> 



  <ogr:PoleLocation fid="F4"> 
   […] 
  <ogr:name> North Pole of Cold </ogr:name> 
  </ogr:PoleLocation> 
 </gml:featureMember> 
</ogr:FeatureCollection> 
 
XML files can be validated to a XML schema (XSD) that ensures that a particular XML 
file only contains data types that are defined in the XML schema. GML uses this 
mechanism to define the data model in a GML application schema and thus, forcing 
GML files to strictly follow the expected data model. 

2.2.2.2 Practical definition in GML application schemas 
Because of what it has just been explained, you must define your own data model as a 
GML application schema (or reuse a previously created data model) and connect your 
GML file to it. By creating your GML application schema, you also create you 
namespace. Please do not be scared by this last word; a namespace is only the group of 
elements and types that define your model. You will also need other preexisting 
namespaces like the GML namespace and the XML Schema instance namespace. It is 
now when things can get complicated. A namespace receives 3 different names in an 
XML file: 

• A short name of typically 2 or 3 characters, which is used to qualify elements in 
XML. 

• A long name in the form of a URI. This is a thing that resembles an http URL, 
but it is not. Since it is only a long name that uses the URL structure to be sure 
that it is unique in the whole world. 

• The real URL position of the XSD file (or files) that defines the namespace. 
To be practical, in the XML file, you could define a default namespace that has no short 
name and is generally assigned to the most used namespace (this is not the case in the 
following example). 
 
The root elements of a typical GML file is FeatureCollection. To connect these elements 
to the right namespaces, you must use the attributes of this element: 
<ogr:FeatureCollection 
 xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
 xmlns:gml="http://www.opengis.net/gml" 
 xmlns:ogr="http://ogr.maptools.org/" 
 xsi:schemaLocation="http://ogr.maptools.org/  
  cryosphere_atlas_north_pole_location.xsd"> 
 
In this GML file you have 3 namespaces: 
short long name (URI) URL 
xsi http://www.w3.org/2001/XMLSchema-

instance 
not needed 

gml http://www.opengis.net/gml still unknown 
ogr http://ogr.maptools.org/ cryosphere_atlas_north_pole_location.

xsd 
 
Our own namespace is called "ogr" as the short name and http://ogr.maptools.org/ as the 
long name, which can be found at: 



cryosphere_atlas_north_pole_location.xsd. This is the file that will define your 
namespace. The root element of your schema defines that the taretNamespace (the 
namespace that will be defined) is http://ogr.maptools.org/. The first child element in 
root is the "import" element that sets the location for the gml namespace to a real URL: 
http://schemas.opengis.net/gml/2.1.2.1/feature.xsd. 
 
<xs:schema xmlns:ogr="http://ogr.maptools.org/"  
 xmlns:xs="http://www.w3.org/2001/XMLSchema"  
 xmlns:gml="http://www.opengis.net/gml"  
 targetNamespace="http://ogr.maptools.org/"  
 elementFormDefault="qualified" version="1.0"> 
 <xs:import namespace="http://www.opengis.net/gml"  
  schemaLocation="http://schemas.opengis.net/gml/2.1.2.1/feature.xsd"/> 
 
Now we are ready to define the Atlas of the Cryosphere North Pole Location data 
model. To do that we only have to define 2 data types: one data type for a 
FeatureCollection and another for features (these are called PoleLocations). This could 
be done in a simple way by using XML schema types, but it is not recommended, 
because we have to ensure both data types are derived from GML types, so instead  we 
can use the geometric types that GML provides (particularly, we need gml:Point in our 
example). 
 
The following UML class model illustrates how FeatureCollection (from the 
FeatureCollectionType) and PoleLocation (from PoleLocationType) are derived from 
GML types (which in turn are also derived from other more primitive GML types). 
GML types are represented in grey in the UML model illustrations. 
 

Formatat: alemany
(Alemanya)



class PoleLocation Model

AbstractFeatureCollectionType

+ featureMembers:  FeatureArrayPropertyType [0..1]

AbstractFeatureType

+ boundedBy:  BoundingShapeType

AbstractGMLType

+ id:  ID
+ metaDataProperty:  MetaDataPropertyType
+ description:  StringOrRefType
+ name:  CodeType

FeaturePropertyType

+ simpleLink

FeatureCollectionType

PoleLocationType

+ Id:  xs:integer
+ name:  xs:string

GeometryPropertyType

+ simpleLink

AbstractGeometryType

+ srsName:  anyURI [0..1]
+ srsDimension:  positiveInteger [0..1]

PointType

+ pos:  DirectPositionType
+ coordinates:  CoordinatesType

PoleLocation becomes an element of 
FeatureCollectionType because is a subclass of 
AbstractFeatureType and because 
FeatureCollectionType subclasses an 
AbstractFeatureCollectionType that has 
featureMember's and each one of them has a _Feature 
element that is of AbstractFeatureType type (the one 
subclassed to PoleLocation)

PoleLocation has a PointType 
element because it has a 
GeometryPropertyType element 
that has a _Geometry that has 
been subclassed to a PointType

+featureMember 0..*

+_Feature

+geometryProperty

+_Geometry

 
This figure shows the inheritance model of the data types (classes and subclasses) 

 
A FeatureCollectionType is a subclass of AbstractFeatureCollectionType which is a 
subclass of AbstractFeatureType that in turn is a subclass of AbstractGMLType. In 
practice this means that a FeatureCollection inherits all elements and attributes of the 
previous ones. 
PoleLocation becomes an element of FeatureCollection because it is a subclass of 
AbstractFeatureType, and a FeatureCollection is composed by a _Feature element or 
some element subclass of AbstractFeatureType type (such as PoleLocation).  
PoleLocation has a Point element because it has a GeometryPropertyType element that 
has a _Geometry that has been subclassed to a PointType. 
 
Fortunately, this inheritance mechanism happens automatically in XML, so the UML 
object model shows all attributes available for the 4 objects that are used in the 
definition of the feature collection. 



object PoleLocation Model

FeatureCollection :FeatureCollectionType

::AbstractFeatureCollectionType
+ featureMembers:  FeatureArrayPropertyType [0..1]
::AbstractFeatureType
+ boundedBy:  BoundingShapeType
::AbstractGMLType
+ id:  ID
+ metaDataProperty:  MetaDataPropertyType
+ description:  StringOrRefType
+ name:  CodeType

PoleLocation :PoleLocationType

::PoleLocationType
+ Id:  xs:integer
+ name:  xs:string
::AbstractFeatureType
+ boundedBy:  BoundingShapeType
::AbstractGMLType
+ id:  ID
+ metaDataProperty:  MetaDataPropertyType
+ description:  StringOrRefType
+ name:  CodeType

geometryProperty :
GeometryPropertyType

::GeometryPropertyType
+ simpleLink

Point :PointType

::PointType
+ pos:  DirectPositionType
+ coordinates:  CoordinatesType
::AbstractGeometryType
+ srsName:  anyURI [0..1]
+ srsDimension:  positiveInteger [0..1]

0..*

 
 

This figure represents the feature instances of the types specified, as well as all the 
properties available from the different class dependencies nested. 

 
The UML models presented here have been elaborated to illustrate the GML class 
dependencies and inheritance model. Latter we will present a simplified version of this 
model that is based on ISO types and on the way that this model can be automatically 
translated into XML.  
 
XMLSpy offers us another view of the same model directly extracted from the XML 
Schema, so in this model more possibilities can be seen which are not shown in the 
UML diagram, although the main idea remains the same. 
 



ogr:FeatureCollectionType

FeatureCollection

attributes

gml:description

gml:name

gml:boundedBy

gml:FeatureAssociationType

gml:featureMember

0 ∞..

attributes

gml:_Feature

ogr:PoleLocationType

PoleLocation

attributes

gml:description

gml:name

gml:boundedBy

gml:GeometryPropertyType

ogr:geometryProperty
attributes

gml:_Geometry

gml:LineString

gml:LinearRing

gml:MultiGeometry

gml:MultiLineString

gml:MultiPoint

gml:MultiPolygon

gml:PointType

gml:Point

attributes

gml:coord

gml:coordinates

gml:Polygon

gml:_GeometryCollection

ogr:id

ogr:name

gml:_FeatureCollection

FeatureCollection

 
Now we are going to illustrate the process of translating manually a data model into a 
GML application schema. In order to do that, we have to do 4 things: 

• Declare the root element FeatureCollection 
• Define a type for the FeatureCollection 
• Declare a PoleLocation element for our features 
• Define a type for the PoleLocation 

 
To declare the root element FeatureCollection is done by creating an element called 
substitutionGroup (subclass of) gml:_FeatureCollection. 
 
 <xs:element name="FeatureCollection" type="ogr:FeatureCollectionType"  
    substitutionGroup="gml:_FeatureCollection"/> 
 
The definition of a type for the FeatureCollection is done by extending 
gml:AbstractFeatureCollectionType. It adds to it a two additional attribute lockId and 
scope. 
 
 <xs:complexType name="FeatureCollectionType"> 
  <xs:complexContent> 
   <xs:extension base="gml:AbstractFeatureCollectionType"> 
    <xs:attribute name="lockId" type="xs:string" use="optional"/> 
    <xs:attribute name="scope" type="xs:string" use="optional"/> 
   </xs:extension> 
  </xs:complexContent> 



 </xs:complexType> 
 
The declaration of a PoleLocation element for our features is done by creating an 
element that is substitutionGroup (subclass of) gml:_Feature. 
 
 <xs:element name="PoleLocation" type="ogr:PoleLocationType"  
    substitutionGroup="gml:_Feature"/> 
 
To define a type for the PoleLocation is an essential step because it is going to define 
how our features will be (defines our feature types). It is done by defining a new type 
that extents gml:AbstractFeatureType.  
 
 <xs:complexType name="PoleLocationType"> 
  <xs:complexContent> 
   <xs:extension base="gml:AbstractFeatureType"> 
    <xs:sequence> 
     […] 
    </xs:sequence> 
   </xs:extension> 
  </xs:complexContent> 
 </xs:complexType> 
 
The sequence of extended elements (and eventually attributes) define the properties of 
features (the only kind in this small example) 
 
The first element added is a geometry property that uses a generic geometry property 
type: gml:GeometryPropertyType. This trick makes possible to use any of the 
generalized types of gml:GeometryPropertyType and particularly a gml:PointType (the 
one we are using). It is of best practice to directly use a type that adjusts best to our data 
model (i.e. gml:PointType in our case), but it is of common practice to use a more 
generic one such as gml:GeometryPropertyType 
 
     <xs:element name="geometryProperty" 
type="gml:GeometryPropertyType" nillable="true"/> 
 
Following the geometric element, we have two elements that are not GML types but 
common XML types (i.e. xs:integer and xs:string) restricted to follow convenient 
limitations: 
 
     <xs:element name="id" nillable="true" minOccurs="0"> 
      <xs:simpleType> 
       <xs:restriction base="xs:integer"> 
        <xs:totalDigits value="6"/> 
       </xs:restriction> 
      </xs:simpleType> 
     </xs:element> 
     <xs:element name="name"nillable="true" minOccurs="0"> 
      <xs:simpleType> 
       <xs:restriction base="xs:string"> 
        <xs:maxLength value="50"/> 



       </xs:restriction> 
      </xs:simpleType> 
     </xs:element> 
 

2.2.2.3 GML application schemas from UML models 
Many GML application schemas are elaborated directly in a XML editor like XMLSpy, 
but this requires the user to be XML proficiency. Another approach is to design them 
using ISO 19103 conformant UML model, and then the GML application schema can 
be created by following the rules given in the GML standard (Annex E of ISO 19136). 
In deed, conversion from simple UML models to GML application schemas is an 
important step to simplify the GML application schema creation. Some tools have 
automated the migration from UML to GML application schema, so one no longer has 
to worry about XML schemas. Fullmoon 
(https://www.seegrid.csiro.au/wiki/AppSchemas/ApplicationSchemaDesign and 
http://projects.arcs.org.au/trac/fullmoon/wiki/FullMoon) and ShapeChange 
(http://www.interactive-instruments.de/ugas/) are two open source software solutions 
that partially automate the process. 
FullMoon provides a more complete environment, but the process of preparing the 
environment is quite complicated (even if you use the setup wizard, you have to follow 
several additional steps), so it is only recommended for complex projects maintained by 
specialists (www.fig.net/pub/fig2011/papers/ts03i/ts03i_kuczynska_chojka_5206.pdf). 
ShapeChange is a Java based command line tool that has a manual setup process, which 
is not simple either, although it has a more limited number and clearer steps. 
 
We are going to illustrate the use of ShapeChange v1.0rc to generate GML application 
schemas from UML models. 
 

2.2.2.3.1 ShapeChange setup 
Shapechange requires Java, Xerces and Xalan. 

• Java JDK can be obtained from 
http://www.oracle.com/technetwork/java/javase/downloads/index.html 

• Xerces 2 for java can be obtained from http://xerces.apache.org/xerces2-j/ 
• Xalan for java http://xml.apache.org/xalan-j/ 

 
In this example we have downloaded: jdk-6u20-windows-i586.exe, Xerces-J-
bin.2.11.0.zip and xalan-j_2_7_1-bin-2jars.zip. Once you setup the java JDK using the 
setup wizard, you have to uncompress Xerces-J-bin.2.11.0.zip and xalan-j_2_7_1-bin-
2jars.zip and only copy the jar files to a new "endorsed" folder in your java "lib" folder 
(by default: "c:\Program Files\Java\jdk1.6.0_20\lib\endorsed" (some files are already 
duplicated in both zip files, and you just have to keep the newer one). 
 



 
 
Then, you can proceed to install the ShapeChange tool by downloading it from 
http://www.interactive-instruments.de/fileadmin/gdi/dwnlds/ugas/ShapeChange-
v1.0rc.zip and decompress it in a folder. 
 
ShapeChange is prepared to generate GML 3.2 (ISO version) by default. In this 
example, we want to be compatible with WFS 1.1 and GML 3.1.1. These will require 
small modifications in the ShapeChange configuration. ShapeChange main 
configuration is stored in the ShapeChangeConfiguration.xml file from the 
"ShapeChange-1.0\config" folder. Actually, the file only contains pointers to three files 
that store respectively, aliases for UML stereotypes, URI namespaces and 
transformation mappings from UML attributes and types to GML elements. This file 
can be duplicated to support alternative configurations. In our case, we have cloned it to 
ShapeChangeConfigurationGML311.xml. Then we have edited it to point to two new 
configurations files: 
<?xml version="1.0" encoding="UTF-8"?> 
<ShapeChangeConfiguration xmlns:xi="http://www.w3.org/2001/XInclude" 
xmlns="http://www.interactive-instruments.de/ShapeChange/Configuration" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://www.interactive-
instruments.de/ShapeChange/Configuration ShapeChangeConfiguration.xsd"> 
 <xi:include href="StandardAliases.xml"/> 
 <xi:include href="StandardNamespacesGML311.xml"/> 
 <xi:include href="StandardMapEntriesUML.xml"/> 
</ShapeChangeConfiguration> 
 



StandardNamespacesGML311.xml was created by cloning StandardNamespaces.xml 
and editing the GML namespace to point to the 3.1.1. 
<Namespace nsabr="gml" ns="http://www.opengis.net/gml" 
location="http://schemas.opengis.net/gml/3.1.1/base/gml.xsd" /> 
 
Also, StandardMapEntriesUML.xml was created by cloning StandardMapEntries.xml 
and introducing a new line for convenience. 
<MapEntry type="String" xsdEncodingRules="iso19136_2007 
iso19136_2007_ShapeChange_1.0_Extensions" xmlPropertyType="string" 
xmlType="string" /> 
 

2.2.2.3.2 UML model edition 
We are going to create our UML model in Enterprise Architect v8.0. The UML model 
for our pole location example will look very simple, since we have only one feature type 
called PoleLocation with three properties. 
 

class PoleLocation ISO model

«featureType»
PoleLocation

+ geometryProperty:  GM_Point
+ id:  Integer
+ name:  String

 
 
In Enterprise Architect v8.0 we will create a new project and generate a Domain Model. 



 
 
We will remove Class1, Class2 and Class3 classes that EA creates automatically as 
examples, and then we will open the Domain Object diagram. We will create a new 
class by dragging and dropping a class from the toolbox in the Domain Object diagram. 
This class will be named PoleLocation and will have a "featureType" stereotype 
(featureType is not on the stereotypes drop down list, and it needs to be typed in). As a 
language we will select <none> and accept the dialog box. 
 

class Domain Objects

«featureType»
PoleLocation

 
 
Now we are going to add attributes to the class: The first one will be named 
geometryProperty and will have the GM_Point type (this will be a public scope 
attribute). ShapeChange uses the geographical feature datatypes defined in ISO 19107 
and GM_Point is an ISO datatype for a point. You can find some of these type names in 
the freely available ISO_TC _211_Standards_Guide.pdf document, specifically, in 
Figure 4 _Geometry basic classes with specialization relations, as well as in the GML 



3.1.1 specification, illustrated in Figure 13. You can also see the comprehensive list of 
supported geospatial ISO data types and their corresponding GML types in the 
StandardMapEntriesUML.xml file. The second attribute will be named "id" and it will 
be an Integer type. Finally, the third attribute will be named "name" and it will be a 
String type (theses types are on the Type drop down list). In the class diagram you will 
see: 
 

class Domain Objects

«featureType»
PoleLocation

+ geometryProperty:  GM_Point
+ id:  Integer
+ name:  String

 
 
At this point we are almost done; now, in order for the ShapeChange tool to work you 
just need to specify which package in the project is the application schema package (this 
step has to be done even if you have only one package). To do that, you have to mark 
this package as an "applicationSchema" stereotype.  
 

 
 
Note that now a useful trick needs to be done for the ShapeChange to communicate with 
the XML abbreviated namespace, namespace URI and XSD filename. This is done by 
adding to the applicationSchema package the following tagged values: 
 
RationalRose$ShapeChange:version 1.0 
RationalRose$ShapeChange:xsdName PoleLocation.xsd 
RationalRose$ShapeChange:xmlNamespaceAbbreviation ogr 
RationalRose$UGAS:version 1.0 
RationalRose$UGAS:xmlns ogr 
RationalRose$UGAS:xsdDocument PoleLocation.xsd 
RationalRose$UGAS:targetNamespace http://ogr.maptools.org 
RationalRose$UGAS:xsdEncodingRule iso19136_2007 
This is an important step (if you miss it, the ShapeChange will not produce the result) , 
which is not explained in the installing documentation that comes with the program. In a 
project with more than one package, it will result in more than one file. The 
RationalRose$ShapeChange tagged values have to be documented in the package that 
will become the main applicationSchema, and the RationalRose$UGAS values have to 
be included in all packages. 



In this example, we are using the same values as the one in pole location original 
example. 
 

 
 

2.2.2.3.3 Automatically application schema generated by ShapeChange. 
 
Let’s now explain how to export the UML model fromUML 1.3 (XMI 1.0) to an xml 
file (Project|ImportExport|Export Package to XM) 
 



 
 
We will export the "PoleLocationXMI.xml" xmi file into the "input" directory of the 
ShapeChange setup. 
 
Now we are going to execute the ShapeChange from the command line and from the 
"input" directory. Simply by typing: 
 
"C:\Archivos de programa\Java\jdk1.6.0_20\bin\java"  
-Djava.endorsed.dirs="C:\Archivos de programa\Java\jdk1.6.0_20\lib\endorsed"  
-Xms128m -Xmx1024m  
-jar "../bin/ShapeChange.jar"  
-o "../result" -s -P -v 3.1 -D NONE -r DEBUG  
-c "../config/ShapeChangeConfigurationGML311.xml"  
-R "iso19136_2007_ShapeChange_1.0_Extensions" PoleLocationXMI.xml 
 
The result will be stored in the "result" directory. 
 
Using "-r DEBUG" will result in reporting the maximum level of the process 
information: 
 
D Added tagged value 'version' for element with ID 
'EAPK_C0C177F7_A154_44b4_BD1A_F3A9999E3678' with value: 1.0. 
D Added tagged value 'version' for element with ID 
'EAPK_C0C177F7_A154_44b4_BD1A_F3A9999E3678' with value: 1.0. 
D Added tagged value 'xsdDocument' for element with ID 
'EAPK_C0C177F7_A154_44b4_BD1A_F3A9999E3678' with value: PoleLocation.xsd. 
D Added tagged value 'xmlns' for element with ID 
'EAPK_C0C177F7_A154_44b4_BD1A_F3A9999E3678' with value: ogr. 



D Added tagged value 'version' for element with ID 
'EAPK_C0C177F7_A154_44b4_BD1A_F3A9999E3678' with value: 1.0. 
D Added tagged value 'xmlns' for element with ID 
'EAPK_C0C177F7_A154_44b4_BD1A_F3A9999E3678' with value: ogr. 
D Added tagged value 'xsdDocument' for element with ID 
'EAPK_C0C177F7_A154_44b4_BD1A_F3A9999E3678' with value: PoleLocation.xsd. 
D Added tagged value 'targetNamespace' for element with ID 
'EAPK_C0C177F7_A154_44b4_BD1A_F3A9999E3678' with value: 
http://ogr.maptools.org. 
D Added tagged value 'xsdEncodingRule' for element with ID 
'EAPK_C0C177F7_A154_44b4_BD1A_F3A9999E3678' with value: iso19136_2007. 
D Added tagged value 'version' for element with ID 
'EAID_15E40ACC_24C0_4c83_9380_81C311E8B73A' with value: 1.0. 
D Added stereotype 'Application Schema' for element with ID 
'EAPK_C0C177F7_A154_44b4_BD1A_F3A9999E3678'. 
D Application schema found, package name: Domain Objects 
D Added stereotype 'featureType' for element with ID 
'EAID_15E40ACC_24C0_4c83_9380_81C311E8B73A'. 
D The package with ID MX_EAID_C0C177F7_A154_44b4_BD1A_F3A9999E3678 
and name 'EA 
Model' was created. Namespace: <null>. 
D The package with ID EAPK_C0C177F7_A154_44b4_BD1A_F3A9999E3678 and 
name 'Domain 
 Objects' was created. Namespace: http://ogr.maptools.org. 
D Processing Classes... 
D The class with ID EAID_11111111_5487_4080_A7F4_41526CB0AA00 and name 
'EARootCl 
ass' was created. 
D The property with ID eaxmiid2 and name 'geometricProperty' was created. 
D The property with ID eaxmiid4 and name 'id' was created. 
D The property with ID eaxmiid6 and name 'name' was created. 
D The class with ID EAID_15E40ACC_24C0_4c83_9380_81C311E8B73A and name 
'PoleLoca 
tion' was created. 
D The class with ID eaxmiid5 and name 'Integer' was created. 
D The class with ID eaxmiid7 and name 'String' was created. 
D The class with ID eaxmiid3 and name 'GM_Point' was created. 
D Fixing Unknowns... 
D Checking overloading. Class = Integer; current class = Integer. 
D Checking overloading. Class = PoleLocation; current class = PoleLocation. 
D Checking overloading. Class = String; current class = String. 
D Checking overloading. Class = EARootClass; current class = EARootClass. 
D Checking overloading. Class = GM_Point; current class = GM_Point. 
D Generating XML Schema for application schema Domain Objects. 
D Creating XSD document 'PoleLocation.xsd' for package Domain Objects. 
D Processing class PoleLocation. 
D Processing class 'PoleLocation', rule 'iso19136_2007'. 
D Import to namespace 'http://www.opengis.net/gml' added. 
D Processing local properties of class PoleLocation. 
D Found: gml:PointPropertyType - direct 



D Found: integer - direct 
D Found: string – direct 
 
The resulting xml file is the GML application schema automatically generated from the 
UML application schema: 
 
<?xml version="1.0" encoding="windows-1252"?> 
<schema xmlns="http://www.w3.org/2001/XMLSchema" 
xmlns:gml="http://www.opengis.net/gml" xmlns:ogr="http://ogr.maptools.org" 
targetNamespace="http://ogr.maptools.org" elementFormDefault="qualified" 
version="1.0"> 
 <import namespace="http://www.opengis.net/gml" 
schemaLocation="http://schemas.opengis.net/gml/3.1.1/base/gml.xsd"/> 
 <!--XML Schema document created by ShapeChange--> 
 <element name="PoleLocation" type="ogr:PoleLocationType" 
substitutionGroup="gml:_Feature"/> 
 <complexType name="PoleLocationType"> 
  <complexContent> 
   <extension base="gml:AbstractFeatureType"> 
    <sequence> 
     <element name="geometryProperty" 
type="gml:PointPropertyType"/> 
     <element name="id" type="integer"/> 
     <element name="name" type="string"/> 
    </sequence> 
   </extension> 
  </complexContent> 
 </complexType> 
 <complexType name="PoleLocationPropertyType"> 
  <sequence minOccurs="0"> 
   <element ref="ogr:PoleLocation"/> 
  </sequence> 
  <attributeGroup ref="gml:AssociationAttributeGroup"/> 
 </complexType> 
</schema> 

2.2.2.3.4 Generating a feature collection from the automatically generated 
application schema. 
A pole location GML file is a feature collection of PoleLocation elements. 
ShapeChange does not generate any Type for feature collections, but we can reuse an 
element that already exists in wfs schemas by specifying the location of both our 
application schema (PoleLocation.xsd) and the wfs schemas. 
 
A GML file that includes a single GML point with the position of the geographic north 
pole (0.0 0.0) looks like this: 
 
<?xml version="1.0" encoding="UTF-8"?> 
<wfs:FeatureCollection xmlns="http://ogr.maptools.org" 
xmlns:wfs="http://www.opengis.net/wfs" xmlns:gml="http://www.opengis.net/gml"  
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 



xsi:schemaLocation="http://ogr.maptools.org PoleLocation.xsd 
http://www.opengis.net/wfs http://schemas.opengis.net/wfs/1.1.0/wfs.xsd"> 
<gml:featureMember> 
 <PoleLocation gml:id="F0"> 
  <geometryProperty> 
   <gml:Point> 
    <gml:pos>0.0 0.0</gml:pos> 
   </gml:Point> 
  </geometryProperty> 
  <id>0</id> 
  <name>Geographic North Pole</name> 
 </PoleLocation> 
</gml:featureMember> 
</wfs:FeatureCollection> 
 
 

2.2.2.4 GML profiles 
(This text is based on a blog from Ron Lake :http://www.galdosinc.com/archives/192 
and this list: http://www.ogcnetwork.net/gmlprofiles) 
 
GML 3 includes a wide range of elements and data types in 0, 1, 2 and 3 dimension for 
geometric, topologic, temporary objects, coverages, CSRs, dictionaries, default styles, 
etc. GML xsd files are arranged in a modular fashion and you only need to import 
geometryBasic0D1D.xsd for different applications. Many people though, find GML 3.1 
possibilities overwhelming and prefer a more limited subset of them. Generic GML 
profiles lower the entry bar facilitating the understanding of a GML and making it easier 
to apply and to be read by GML parsers (while improving interoperability). This 
ensures that the application schemas developed with these profiles, avoid loading 
components that will never be used. These profiles live in the GML namespaces 
(http://www.opengeospatial.org/standards/gml) and define restricted subsets of GML. In 
other words, any application schema that can be generated using a profile must also be a 
valid application schema with respect to the full GML specification. Examples of this 
kind of profiles are: 
 

• A very simple GML Point Profile aimed at specification developers that have 
point geometric data but do not want to use the GML grammar.  

• A simple GML for Simple Features profile aimed at supporting vector feature 
requests and transactions (e.g. to/from a WFS).  

• A GML profile for GMJP2 (GML in JPEG 2000)  
• A GML profile for RSS (discussed below) 

 
Another kind of GML profile provides the basis for domain or community specific 
GML application schemas, which in turn support data interoperability within a 
community of interest. This profile incorporates new XML vocabularies defined using 
GML and which lives in an application-defined target namespace. 
 
GML application schemas can be built on specific GML profiles or the full GML 
schema set can be used. 
 



2.2.2.5 Using Simple feature profile. 
(This text is based on the blog from Ron Lake :http://www.galdosinc.com/archives/192 
and the simple features profile specification document OGC 10-100) 
 
The GML Profile for Simple Features provides enough support for a wide range of 
vector feature objects. It includes:  
 
[1] A reduced geometry model allowing 0d, 1d and 2d linear geometric objects (all 

based on linear interpolation) and the corresponding aggregated geometries 
(gml:MultiPoint, gml:MultiCurve, etc). 

[2] A simplified feature model which can only be one level deep (in the general 
GML model, arbitrary nesting of features and feature properties is not 
permitted). 

[3] All non-geometric properties must be XML Schema simple types – i.e. cannot 
contain nested elements. 

[4] Remote property value references are used (xlink:href),  just like in the main 
GML specification. 

Since the profile aims to provide a simple entry point, it does not provide support for 
coverage, topology, observations, value objects (for real time sensor data), nor support 
for dynamic features. 
 
Simple features profile defines three compliance levels called SF-0, SF-1, and SF-2. 
Compliance level SF-0 limits the property types of both spatial and non-spatial 
properties. Non-spatial properties are limited to being one of the following common xml 
types: integer, measurement, date, boolean, binary, URI, character or real; and 
cardinality of non-spatial properties is limited to zero or one (not allowing more that 
one). Spatial properties are limited to being one of the following GML types: point, 
curve with linear and/or circular arc interpolation, planar surface, or aggregates thereof. 
In GML instance documents compliant with level SF-0, values for a particular property 
may be encoded inline or by-reference but not both. By-reference property values are 
only supported through the use of the type gml:ReferenceType (the more generalized 
GML property-type pattern allowing mixed inline and by-reference encoded property 
values within the same instance document is disallowed in this level). 
Compliance level SF-1 supports everything in compliance level SF-0 but removes the 
restriction on value cardinality (allowing more that one occurrence of the same property 
per object) and allows user defined non-spatial property types to be used. As with 
compliance level SF-0, in GML instance documents compliant with level SF-1, values 
for a particular property may be encoded inline or by-reference but not both. By-
reference property values are only supported through the use of the type 
gml:ReferenceType. 
Finally, compliance level SF-2 essentially corresponds to the OGC Simple Features 
specification. There are no restrictions placed on non-spatial properties. Spatial 
properties, however, are limited to the set of geometric types supported by compliance 
levels SF-0 and SF-1. In instance documents, the restriction on remote or referenced 
geometric property values, found in compliance levels SF-0 and SF-1, is removed 
 
Nonetheless, it supports a good variety of real world problems and it is quite useful. It is 
the right profile to convert a Shapefile (SHP) to GML data because Shapefiles have 
similar limitations. 



2.2.2.6 GML media type 
When submitting a request to a service or when receiving a response from a service 
using a GML file, a GML media type format has to be specified. Previously, in OGC 
several notations where used for this particular media type (e.g. WFS 1.0 uses "GML2", 
WFS 1.1 uses ""text/xml; subtype=gml/3.1.1" and GML simple features profiles 
suggests text/xml; subtype=gml/3.1.1/sfgml). 
 
All this notations have been set aside in favor of a standard media type 
"application/gml+xml" (OGC 09-144r1. 
http://portal.opengeospatial.org/files/?artifact_id=37743). This MIME type has been 
submitted to IETF for approval: http://tools.ietf.org/html/draft-portele-ogc-gml-mime-
01, which it only has 2 optional parameters: "charset" and "version". For "version" only 
the major and the first minor version number are provided. 
 
To refer to a particular GML version 3.2 you can use: 
"application/gml+xml; version=3.2". References to profile are no longer allowed. 
 

2.2.2.7 The axis order issue. 
In the previous discussion we have ignored the coordinate reference system upon which 
the position of geospatial objects rely. In previous examples, we used a polar 
stereographic projection because data came from an arctic zone dataset. One of the most 
common geospatial reference systems is latitude/longitude in WGS84 (EPSG code 
database identifier: 4326). The reference system can be specified by adding an attribute 
to the gml:Point. 
<gml:Point srsName="urn:EPSG:geographicCRS:4326"> 
(This notation for CRS names comes from the GML 3.1.1 standard examples and it is 
deprecated; currently OGC is recommending URIs instead of URNs) 
 
There is a known issue with the axis order interpretation in the EPSG:4326. OGC edited 
the document 08-038r5 (http://www.ogcnetwork.net/node/491) to settle down this issue 
and to determine the axis order specified in the EPSG database in order to be adopted 
by all OGC standards. In practice, this means that EPSG:4326 shall be used in 
latitude/longitude ordering. 
 
Unfortunately, many implementations of GML, as well as many layers continue 
following the reverse longitude-latitude ordering, this either could be explained because 
implementations where done before 08-038r5 or because they continue ignoring the 
OGC recommended standards. Some GML readers have the capability to specify a 
parameter to invert the coordinates ordering while reading it; this is just a transitory 
solution until implementations progressively adopt the axis order from the OGC policy. 
 
For instance, the service CIESIN/SEDAC WFS Service (Center for International Earth 
Science Information Network (CIESIN), Columbia University; and NASA's 
Socioeconomic Data and Applications Center (SEDAC)) with CSR record 
https://geossregistries.info/geosspub/login.jsp?redirect=component_details.jsp?compId=
urn:uuid:a6554210-6c88-4b81-9625-e0bed5e34b93 has a feature type for IPCC 
assessment that can be obtained as a GML file with this URL: 
http://sedac.ciesin.columbia.edu/geoserver/wfs?service=WFS&request=GetFeature&ver
sion=1.1.0&typeName=ipcc-assess:ipcc-assess-synthetic-assessment-vulnerability-



climate-2005-2050-2100. This dataset honors the axis order OGC policy and represent 
coordinates ordered latitude and longitude.  

 
 
This is what happens if the client does not take into account the right axis ordering and 
supposes first longitude and then latitude: 



 
 

2.2.3 Simple WFS Service Interface. Serving features 
WFS 2.0 defines 4 incremental levels of implementation of WFS: Simple WFS, Basic 
WFS, Transactional WFS and Locking WFS. This allows implementers to limit 
themselves to a minimum set of operations. 
 
For the Simple WFS, the server shall implement the following operations: 
GetCapabilities (all versions), DescribeFeatureType (all versions), ListStoredQueries 
(WFS 2.0 only), DescribeStoredQueries (WFS 2.0 only), GetFeature (all versions) 
operation with only the StoredQuery (WFS 2.0 only). 
One stored query, which fetches a feature using its id, shall be available although the 
server may also offer additional stored queries. This stored query shall have the 
identifier: urn:ogc:def:query:OGC-WFS::GetFeatureById (WFS 2.0 only). In WFS 
version 1.1, a similar functionality was available using the GetGMLObject operation. 
 
To illustrate how WFS works, we are going to use the Atlas of the Cryosphere as an 
example: Northern Hemisphere. The Atlas of the Cryosphere uses mapserver software 
(mapserver.org) over Apache/2.2.3 (Linux/SUSE). 



2.2.3.1 Describing Your WFS Server: The GetCapabilities operation 

2.2.3.1.1 GetCapabilities request 
All OWS Common services are self-describing. In the case of WFS this means that you 
are able to request enough information to the service to know the services details, and 
you can formulate further requests until you gent the desired data. When you already 
have the elements you need to get the data, it is then possible to directly request the 
desired data without a previous information request about the service itself. None the 
less, it is good that the services are self-describing because it allows the discovery of 
other services. To explore a WFS service, the only thing you need is the service URL 
location. There are two possibilities: 

• You have a URL that is a GetCapabilites complete request. In this case, you do 
not need to know anything else. Just using this URL in a web browser will get 
you the service description. This is what the CSR provides. For example, for the 
Atlas of the Cryosphere: Northern Hemisphere WFS CSR record 
(https://geossregistries.info/geosspub/service_details_ns.jsp?serviceId=urn:uuid:
37689b8b-1ffc-40e4-b7d1-e407cb23c7df) you have an entry called "Interface 
URL" that contains: http://nsidc.org/cgi-
bin/atlas_north?service=WFS&request=GetCapabilities 

• You only have the URL of the service application: http://nsidc.org/cgi-
bin/atlas_north. In this case, you will need to add two mandatory parameters that 
are the same for all WFS services version 1.1: http://nsidc.org/cgi-
bin/atlas_north?service=WFS&request=GetCapabilities 

Many WFS implementations support more that one standard version (e.g. you can add 
"&version=1.0.0" to previous requests to get a WFS 1.0 description). In fact, many 
current services support WFS 1.0 and 1.1. If you do not request any version in 
particular, you will then get the latest version available. 

2.2.3.1.2 Capabilities document 
The response of a correct GetCapabilities request is a capabilities document (also 
known as "OGC service metadata document"). This is an XML document that has 
different sections. 



 
In this example we are going to examine the Atlas of the Cryosphere: Northern 
Hemisphere GetCapabilities response document that only uses some of the previous 
sections: 
<?xml version="1.0" encoding="ISO-8859-1"?> 
<wfs:WFS_Capabilities xmlns:gml="http://www.opengis.net/gml" xmlns:wfs="http://www.opengis.net/wfs" 
xmlns:ows="http://www.opengis.net/ows" xmlns:xlink="http://www.w3.org/1999/xlink" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:ogc="http://www.opengis.net/ogc" 
xmlns="http://www.opengis.net/wfs" version="1.1.0" xsi:schemaLocation="http://www.opengis.net/wfs 
http://schemas.opengis.net/wfs/1.1.0/wfs.xsd"> 
 <ows:ServiceIdentification>[…]</ows:ServiceIdentification> 
 <ows:ServiceProvider>[…]</ows:ServiceProvider> 
 <ows:OperationsMetadata>[…]</ows:OperationsMetadata> 



 <FeatureTypeList>[…]</FeatureTypeList> 
 <ogc:Filter_Capabilities>[…]</ogc:Filter_Capabilities> 
</wfs:WFS_Capabilities> 
 
The first two sections do not require much explanation because XML element names 
are quite clear: they provide general information about the service we are going to use 
such as a title, a description, etc., and information about the people responsible to set it 
up, as we can see in this XML fragment: 
 
<ows:ServiceIdentification> 
 <ows:Title>Atlas of the Cryosphere: Northern Hemisphere</ows:Title> 
 <ows:Abstract>The National Snow and Ice Data Center (NSIDC) Atlas of the 
Cryosphere is a map server that provides data and information pertinent to the frozen 
regions of Earth, including monthly climatologies of sea ice extent and concentration, 
snow cover extent, and snow water equivalent, in addition to glacier outlines, 
permafrost extent and classification, ice sheet elevation and accumulation, and more. 
[…] 
 </ows:Abstract> 
 <ows:Keywords> 
  <ows:Keyword>Arctic</ows:Keyword> 
  <ows:Keyword>Cryosphere</ows:Keyword> 
   […] 
 </ows:Keywords> 
 <ows:ServiceType codeSpace="OGC">OGC WFS</ows:ServiceType> 
 <ows:ServiceTypeVersion>1.1.0</ows:ServiceTypeVersion> 
 <ows:Fees>none</ows:Fees> 
 <ows:AccessConstraints>none</ows:AccessConstraints> 
</ows:ServiceIdentification> 
<ows:ServiceProvider> 
 <ows:ProviderName>National Snow and Ice Data Center</ows:ProviderName> 
 <ows:ProviderSite xlink:type="simple" xlink:href="http://nsidc.org"/> 
 <ows:ServiceContact> 
  <ows:IndividualName>NSIDC User Services</ows:IndividualName> 
   […] 
  <ows:PositionName>User Services</ows:PositionName> 
  <ows:ContactInfo> 
    […] 
   <ows:Address> 
       […] 
    <ows:ElectronicMailAddress>nsidc@nsidc.org 
      </ows:ElectronicMailAddress> 
   </ows:Address> 
      […] 
  </ows:ContactInfo> 
  <ows:Role>resourceProvider</ows:Role> 
 </ows:ServiceContact> 
</ows:ServiceProvider> 
 
OperationsMetadata section is more interesting to us because it reviles operations that 
the services support, while allowing us to introduce two further operations: 



DescribeFeatureType and GetFeature. It also describes the supported values for some 
parameters like outputFormat. 
<ows:OperationsMetadata> 
 <ows:Operation name="GetCapabilities">[…]</ows:Operation> 
 <ows:Operation name="DescribeFeatureType"> 
  <ows:DCP> 
   <ows:HTTP> 
    <ows:Get xlink:type="simple"  
    xlink:href="http://nsidc.org/cgi-bin/atlas_north?"/> 
    <ows:Post xlink:type="simple" 
    xlink:href="http://nsidc.org/cgi-bin/atlas_north?"/> 
   </ows:HTTP> 
  </ows:DCP> 
  <ows:Parameter name="outputFormat"> 
   <ows:Value>XMLSCHEMA</ows:Value> 
   <ows:Value>text/xml; subtype=gml/2.1.2</ows:Value> 
   <ows:Value>text/xml; subtype=gml/3.1.1</ows:Value> 
  </ows:Parameter> 
 </ows:Operation> 
 <ows:Operation name="GetFeature"> 
  <ows:DCP> 
   <ows:HTTP> 
    <ows:Get xlink:type="simple"  
    xlink:href="http://nsidc.org/cgi-bin/atlas_north?"/> 
    <ows:Post xlink:type="simple"  
    xlink:href="http://nsidc.org/cgi-bin/atlas_north?"/> 
   </ows:HTTP> 
  </ows:DCP> 
  <ows:Parameter name="resultType"> 
   <ows:Value>results</ows:Value> 
  </ows:Parameter> 
  <ows:Parameter name="outputFormat"> 
   <ows:Value>text/xml; subtype=gml/3.1.1</ows:Value> 
  </ows:Parameter> 
 </ows:Operation> 
</ows:OperationsMetadata> 
 
WMS services structure the service content into layers that have names. A WFS server 
does not do that, so, a WFS server can be seen as an enormous mixed collection of 
features ready to be downloaded. Fortunately, we can filter the information by feature 
types and, in practice, people are using feature type filtering as a way to separate 
content in different units (like we do when separating information into different 
shapefiles. Obviously, it is important to know the name of the contents in order to 
separate the feature type content. The next section, FeatureTypeList, tells us the type 
names as well as many details about each feature type. This service has up to 19 feature 
types, but the following fragment only shows two of them: 
 
 <FeatureTypeList> 
[…] 
  <FeatureType> 



   <Name>greenland_elevation_contours</Name> 
[…] 
  </FeatureType> 
[…] 
  <FeatureType> 
   <Name>north_poles_wfs</Name> 
   <Title>North Poles</Title> 
   <Abstract>Labels the location of various types of North Poles: geographic, 
geomagnetic, magnetic, pole of cold, and pole of inaccessibility. Citations: 
[…]</Abstract> 
   <ows:Keywords> 
    <ows:Keyword>Arctic</ows:Keyword> 
[…] 
   </ows:Keywords> 
   <DefaultSRS>EPSG:32661</DefaultSRS> 
   <OutputFormats> 
    <Format>text/xml; subtype=gml/3.1.1</Format> 
   </OutputFormats> 
   <ows:WGS84BoundingBox dimensions="2"> 
    <ows:LowerCorner>-179.398145800191  
       67.4138497780757</ows:LowerCorner> 
    <ows:UpperCorner>179.629931564272  
       86.7641921273786</ows:UpperCorner> 
   </ows:WGS84BoundingBox> 
  </FeatureType> 
[…] 
 </FeatureTypeList> 
 
Finally, this service supports filtering features by several criteria detailed in the last 
section of the XML file: 
 
 <ogc:Filter_Capabilities> 
  <ogc:Spatial_Capabilities> 
   <ogc:GeometryOperands> 
    <ogc:GeometryOperand>gml:Point</ogc:GeometryOperand> 
    <ogc:GeometryOperand>gml:LineString</ogc:GeometryOperand> 
    <ogc:GeometryOperand>gml:Polygon</ogc:GeometryOperand> 
    <ogc:GeometryOperand>gml:Envelope</ogc:GeometryOperand> 
   </ogc:GeometryOperands> 
   <ogc:SpatialOperators> 
    <ogc:SpatialOperator name="Equals"/> 
    <ogc:SpatialOperator name="Disjoint"/> 
    <ogc:SpatialOperator name="Touches"/> 
    <ogc:SpatialOperator name="Within"/> 
    <ogc:SpatialOperator name="Overlaps"/> 
    <ogc:SpatialOperator name="Crosses"/> 
    <ogc:SpatialOperator name="Intersects"/> 
    <ogc:SpatialOperator name="Contains"/> 
    <ogc:SpatialOperator name="DWithin"/> 
    <ogc:SpatialOperator name="Beyond"/> 



    <ogc:SpatialOperator name="BBOX"/> 
   </ogc:SpatialOperators> 
  </ogc:Spatial_Capabilities> 
  <ogc:Scalar_Capabilities> 
   <ogc:LogicalOperators/> 
   <ogc:ComparisonOperators> 
    <ogc:ComparisonOperator>LessThan</ogc:ComparisonOperator> 
    <ogc:ComparisonOperator>GreaterThan</ogc:ComparisonOperator> 
   
 <ogc:ComparisonOperator>LessThanEqualTo</ogc:ComparisonOperator> 
   
 <ogc:ComparisonOperator>GreaterThanEqualTo</ogc:ComparisonOperator> 
    <ogc:ComparisonOperator>EqualTo</ogc:ComparisonOperator> 
    <ogc:ComparisonOperator>NotEqualTo</ogc:ComparisonOperator> 
    <ogc:ComparisonOperator>Like</ogc:ComparisonOperator> 
    <ogc:ComparisonOperator>Between</ogc:ComparisonOperator> 
   </ogc:ComparisonOperators> 
  </ogc:Scalar_Capabilities> 
  <ogc:Id_Capabilities> 
   <ogc:FID/> 
  </ogc:Id_Capabilities> 
 </ogc:Filter_Capabilities> 
 

2.2.3.2 Describing Your FeatureTypes: The DescribeFeatureType operation 
So far we have been discussing data models in GML and the way to describe them in 
XML application schemas. DescribeFeatureType is used to obtain application schemas. 

2.2.3.2.1 DescribeFeatureType request 
To build a DescribeFeatureType request we use the server URL http://nsidc.org/cgi-
bin/atlas_north and, for the WFS version 1.1, and adding 
"?service=WFS&request=DescribeFeatureType&version=1.1.0&typename=". Then, we 
have two situations: 

• We leave the request like this. Then, we are going to get all feature types in the 
response. 

• We add a list of feature type names separated by comas. FeatureType names can 
be found on the capabilities document for the content of the elements 
"/wfs:WFS_Capabilities/FeatureTypeList/FeatureType[]/Name".  

In our example, we are going to use: north_poles_wfs and 
greenland_elevation_contours. A valid request to this server is: 
http://nsidc.org/cgi-
bin/atlas_north?service=WFS&request=DescribeFeatureType&version=1.1.0&typenam
e=north_poles_wfs,greenland_elevation_contours 

2.2.3.2.2 DescribeFeatureType response: GML application schema 
The response to a well formed DescribeFeatureType request is a GML application 
schema for the requested types. In our example we are getting: 
 
<schema 
  targetNamespace="http://mapserver.gis.umn.edu/mapserver"  



  xmlns:ms="http://mapserver.gis.umn.edu/mapserver"  
  xmlns:ogc="http://www.opengis.net/ogc" 
  xmlns="http://www.w3.org/2001/XMLSchema" 
  xmlns:gml="http://www.opengis.net/gml" 
  elementFormDefault="qualified" version="0.1" > 
 
 <import namespace="http://www.opengis.net/gml" 
   schemaLocation="http://schemas.opengis.net/gml/3.1.1/base/gml.xsd" /> 
 
 <element name="greenland_elevation_contours"  
      type="ms:greenland_elevation_contoursType"  
      substitutionGroup="gml:_Feature" /> 
 
 <complexType name="greenland_elevation_contoursType"> 
  <complexContent> 
   <extension base="gml:AbstractFeatureType"> 
    <sequence> 
     <element name="msGeometry" type="gml:GeometryPropertyType" 
minOccurs="0" maxOccurs="1"/> 
     <element name="Label" type="string"/> 
     <element name="Elevation" type="string"/> 
    </sequence> 
   </extension> 
  </complexContent> 
 </complexType> 
 
 <element name="north_poles_wfs"  
      type="ms:north_poles_wfsType"  
      substitutionGroup="gml:_Feature" /> 
 
 <complexType name="north_poles_wfsType"> 
  <complexContent> 
   <extension base="gml:AbstractFeatureType"> 
    <sequence> 
     <element name="msGeometry" type="gml:GeometryPropertyType" 
minOccurs="0" maxOccurs="1"/> 
     <element name="Id" type="string"/> 
     <element name="NAME" type="string"/> 
    </sequence> 
   </extension> 
  </complexContent> 
 </complexType> 
 
</schema> 
 
In previous sections we have discussed about data models and the translation into GML 
applications schemas. This application schema for the north_poles example has already 
been explained. A particular problem that occurs when implementing it, is that the 
gml:GeometryPropertyType hides the actual geometric objects used to describe both 
feature types. We already know that north_poles will be expressed as GML points and 



we suppose that greenland_elevation_contoursType will be expressed as GML 
linestrings, but we can not confirm it until we actually request the features. This is why 
we would recommend that a more concrete subclass of gml:AbstractFeatureType was 
used instead. It is also surprising that "Elevation" has a "string" type valure since we 
expect numbers in it. 

2.2.3.3 Serving a Feature collection: The GetFeature operation 
This operation allows us to retrieve a subset of the features that the WFS stores. 

2.2.3.3.1 Implementing GetFeature: Required Parameters 
To build a DescribeFeatureType request we use the server URL http://nsidc.org/cgi-
bin/atlas_north and, for the WFS version 1.1, we add "http://nsidc.org/cgi-
bin/atlas_north?service=WFS&request=GetFeature&version=1.1.0&typename=". Then 
we add a coma separated list of feature type names. FeatureType names can be found on 
the capabilities document for the content of the elements 
"/wfs:WFS_Capabilities/FeatureTypeList/FeatureType[]/Name".  
In our example, we use: north_poles_wfs or greenland_elevation_contours. 
Request of features for both feature types will be something like this: 
http://nsidc.org/cgi-
bin/atlas_north?service=WFS&request=GetFeature&version=1.1.0&typename=north_p
oles_wfs 
and 
http://nsidc.org/cgi-
bin/atlas_north?service=WFS&request=GetFeature&version=1.1.0&typename=greenla
nd_elevation_contours 
 

2.2.3.3.2 GetFeature Response. GML data 
The response to a well formed GetFeature request is a GML application schema for the 
requested types. In our first example we get: 
 
<wfs:FeatureCollection xmlns:ms="http://mapserver.gis.umn.edu/mapserver" 
xmlns:gml="http://www.opengis.net/gml" xmlns:wfs="http://www.opengis.net/wfs" 
xmlns:ogc="http://www.opengis.net/ogc" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://mapserver.gis.umn.edu/mapserver http://nsidc.org/cgi-
bin/atlas_north?SERVICE=WFS&amp;VERSION=1.1.0&amp;REQUEST=DescribeFe
atureType&amp;TYPENAME=north_poles_wfs http://www.opengis.net/wfs 
http://schemas.opengis.net/wfs/1.1.0/wfs.xsd"> 
 <gml:boundedBy> 
  <gml:Envelope srsName="EPSG:32661"> 
   <gml:lowerCorner>903627.830798 1639531.171915</gml:lowerCorner> 
   <gml:upperCorner>3845580.759766 3744059.030924</gml:upperCorner> 
  </gml:Envelope> 
 </gml:boundedBy> 
 <gml:featureMember> 
  <ms:north_poles_wfs gml:id="north_poles_wfs.0"> 
   <gml:boundedBy> 
    <gml:Envelope srsName="EPSG:32661"> 
     <gml:lowerCorner> 



     2000000.000000 2000000.000000</gml:lowerCorner> 
     <gml:upperCorner> 
     2000000.000000 2000000.000000</gml:upperCorner> 
    </gml:Envelope> 
   </gml:boundedBy> 
   <ms:msGeometry> 
    <gml:Point srsName="EPSG:32661"> 
     <gml:pos>2000000.000000 2000000.000000</gml:pos> 
    </gml:Point> 
   </ms:msGeometry> 
   <ms:Id>0</ms:Id> 
   <ms:NAME>Geographic North Pole</ms:NAME> 
  </ms:north_poles_wfs> 
 </gml:featureMember> 
 <gml:featureMember> 
  <ms:north_poles_wfs gml:id="north_poles_wfs.1"> 
[…] 
   <ms:msGeometry> 
    <gml:Point srsName="EPSG:32661"> 
     <gml:pos>1256015.530206 2337486.323100</gml:pos> 
    </gml:Point> 
   </ms:msGeometry> 
   <ms:Id>0</ms:Id> 
   <ms:NAME>Magnetic North Pole (2005)</ms:NAME> 
  </ms:north_poles_wfs> 
 </gml:featureMember> 
 <gml:featureMember> 
[…] 
 </gml:featureMember> 
</wfs:FeatureCollection> 
 
It is interesting to see that the xsi:schemaLocation of the GML application schema is a 
dynamically generated document that is in fact a DescribeFeatureType request, which 
will return a GML application schema for these features. 
 
Sometimes things do not work fully as expected. The complete response from the WFS 
service does not validate in XMLSpy. This is due to some mismatching problems, 
firstly, the DescribeFeatureType has an optional parameter 
OutputFormat=text/xml; subtype=gml/3.1.1 (with a space in it), this makes the schema 
location unreadable. We can fix this by removing this optional parameter, leaving the 
default value as indicated. Secondly, all gml_id attributes were set to "0", XMLSpy 
detects this as a violation of the uniqueness of the identifier. The xml fragment 
illustrated here fixes both issues. 
 
In our second example we get: 
 
<wfs:FeatureCollection xmlns:ms="http://mapserver.gis.umn.edu/mapserver" 
xmlns:gml="http://www.opengis.net/gml" xmlns:wfs="http://www.opengis.net/wfs" 
xmlns:ogc="http://www.opengis.net/ogc" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 

Formatat: espanyol (Espanya
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xsi:schemaLocation="http://mapserver.gis.umn.edu/mapserver http://nsidc.org/cgi-
bin/atlas_north?SERVICE=WFS&amp;VERSION=1.1.0&amp;REQUEST=DescribeFe
atureType&amp;TYPENAME=greenland_elevation_contours 
http://www.opengis.net/wfs http://schemas.opengis.net/wfs/1.1.0/wfs.xsd"> 
[…] 
 <gml:featureMember> 
  <ms:greenland_elevation_contours> 
   <gml:boundedBy> 
    <gml:Envelope srsName="EPSG:32661"> 
     <gml:lowerCorner> 
    -327189.501776 -456661.863393</gml:lowerCorner> 
     <gml:upperCorner> 
    -327164.993574 -456636.649888</gml:upperCorner> 
    </gml:Envelope> 
   </gml:boundedBy> 
   <ms:msGeometry> 
    <gml:LineString srsName="EPSG:32661"> 
     <gml:posList srsDimension="2">-327164.993574 -456638.840870 -
327189.501776 -456636.649888 -327183.636846 -456661.863393 -327168.660334 -
456653.526955 -327164.993574 -456638.840870 </gml:posList> 
    </gml:LineString> 
   </ms:msGeometry> 
   <ms:Label>1000 m</ms:Label> 
   <ms:Elevation>1000.000000</ms:Elevation> 
  </ms:greenland_elevation_contours> 
 </gml:featureMember> 
 <gml:featureMember> 
  <ms:greenland_elevation_contours> 
[…] 
 </gml:featureMember> 
[…] 
</wfs:FeatureCollection> 
 
As expected, the second example has a geometric element of the gml:LineStringType (a 
sequence of coordinates). Also, the "Elevation" is a decimal number so it would be 
better to use xs:decimal instead of xs:string in the definition of the 
greenland_elevation_contours type. 

2.2.3.4. Exceptions 
Sometimes the client does not provide a well formed supported request or for some 
reason, the service is not able to perform the requested task. Under these circumstances, 
the service will respond with an XML file that explains the origin of the problem. 
 
For example, if we send a GetCoverage request to a WFS service: 
http://nsidc.org/cgi-
bin/atlas_north?service=WFS&request=GetCoverage&version=1.1.0 
it will generate an exception like this: 
<ows:ExceptionReport xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xmlns:ows="http://www.opengis.net/ows/1.1" version="1.1.0" xml:lang="en-US" 



xsi:schemaLocation="http://www.opengis.net/ows/1.1 
http://schemas.opengis.net/ows/1.1.0/owsExceptionReport.xsd"> 
 <ows:Exception exceptionCode="request" locator="InvalidParameterValue"> 
  <ows:ExceptionText>msWFSDispatch(): WFS server error. Invalid WFS 
request: GetCoverage</ows:ExceptionText> 
 </ows:Exception> 
</ows:ExceptionReport> 
 
The sentence: "Invalid WFS request: GetCoverage" reveals the reason of the problem.  

• If the origin of the problem is in our side, we could try to identify it and fix it. 
• If the origin of the problem is not in our side, there isn't much to be done except 

to contact the service provider using the contact information available in the 
ServiceProvider section of the capabilities document. 

 
This is an example of a situation where we cannot fix the problem: 
<ows:ExceptionReport> 
 <ows:Exception exceptionCode="NoApplicableCode"> 
  <ows:ExceptionText>java.io.FileNotFoundException: Shapefile not 
found:file:/usr/local/geoserver/data_dir/data/sibessc/external/iiasa_landresourc/soils/soil
nat_dd.shp</ows:ExceptionText> 
 </ows:Exception> 
</ows:ExceptionReport> 
 
The exception report seems to suggest a missing file, but since we do not have access to 
the service file system, we cannot fix the problem ourselves. This problem was found in 
the Siberian Earth System Science Cluster WFS service (CSR urn:uuid:1fc2a913-7739-
48e2-8222-d1fd2e2f79fd) trying to test a GetGmlObject operation. 

 

2.2.4 Basic WFS Service Interface. Creating new queries 
A basic WFS server shall implement the Simple WFS operations, and additionally it 
shall implement the GetFeature operation with the Query action and the 
GetPropertyValue operation. All these additions to the Simple WFS have been 
introduced in WFS 2.0, so previous versions of the standard do not have this level. 

2.2.4.1 Forgetting about geometries: The GetPropertyValue operation 
Sometimes there is the need for getting specific information about features without 
getting the geometrical description (since that for linestrings or polygons could take 
long). WFS 2.0 introduces a new operation that is similar to GetFeature but permits the 
selection of the properties recovered.  

2.2.5 Transactional WFS Service Interface. Updating features 
A transactional WFS server (many times referred to as WFS-T) shall implement the 
Basic WFS operations and it shall also implement the Transaction operation. The 
transaction operation is a 4 in 1 operation that changes the direction of the information 
flow. With this operation the user is able to send information to the server and update 
the data stored in the server. The data becomes immediately available to others. It is 
composed of 4 operations: "insert", "update” and "delete" and other possible vendor 
specific operations using the "native" operation. 



2.2.5.1 Implementing an Insert Transaction: Required Parameters 
It will be more complicated to illustrate this feature, mainly because the data that has to 
be sent to the server can not be easily carried through the URL in the form of key and 
value pairs (what is known as HTTP-GET method with KVP parameters), but it has to 
be transported in an XML file.  
 
In this example, we are going to use the Haiti SDI VGI WFS-T example 
(https://geossregistries.info/geosspub/service_details_ns.jsp?serviceId=urn:uuid:e234ac
3c-9e55-41de-9908-dfed4d3fe9ef). It is a Web Feature Server implemented using the 
CubeWerx Suite 5.5.2. 
 
We know this service supports transactions because the OperationsMetadata section in 
the Capabilities document declares to support this operation 
(http://portal.cubewerx.com/cubewerx/cubeserv/cubeserv.cgi?CONFIG=haiti_vgi&DA
TASTORE=vgi&service=WFS&request=GetCapabilities): 
 
 <ows:OperationsMetadata> 
  <ows:Operation name="GetCapabilities">[…]</ows:Operation> 
  <ows:Operation name="DescribeFeatureType">[…]</ows:Operation> 
  <ows:Operation name="GetFeature">[…]</ows:Operation> 
  <ows:Operation name="Transaction">[…]</ows:Operation> 
   <ows:DCP> 
    <ows:HTTP> 
     <ows:Post 
xlink:href="http://portal.cubewerx.com/cubewerx/cubeserv/cubeserv.cgi?CONFIG=hait
i_vgi&amp;DATASTORE=vgi"/> 
    </ows:HTTP> 
   </ows:DCP> 
[…] 
   <ows:Parameter name="idgen"> 
    <ows:Value>GenerateNew</ows:Value> 
   </ows:Parameter> 
[…] 
  </ows:Operation> 
[…] 
 <ows:OperationsMetadata> 
 
From the set of FeatureTypes available on this service we have chosen one that is called 
cw:POINTS. 
 
  <FeatureType> 
   <Name>cw:POINTS</Name> 
   <Title>Points of Interest</Title> 
   <DefaultSRS>EPSG:4326</DefaultSRS> 
   <ows:WGS84BoundingBox> 
    <ows:LowerCorner>-74.4074639 17.8961279</ows:LowerCorner> 
    <ows:UpperCorner>-68.3466872 20.0086847</ows:UpperCorner> 
   </ows:WGS84BoundingBox> 
  </FeatureType> 
 



We also know the GML application schema that describes them using 
http://portal.cubewerx.com/cubewerx/cubeserv/cubeserv.cgi?CONFIG=haiti_vgi&DAT
ASTORE=vgi&service=WFS&version=1.1.0&request=DescribeFeatureType&TypeNa
me=cw:POINTS: 
 
<xs:schema targetNamespace="http://www.cubewerx.com/cw" 
xmlns:cw="http://www.cubewerx.com/cw" 
xmlns:xs="http://www.w3.org/2001/XMLSchema" 
xmlns:gml="http://www.opengis.net/gml" 
xmlns:cwmeta="http://www.cubewerx.com/cwmeta" elementFormDefault="qualified" 
version="1.0"> 
 <xs:import namespace="http://www.opengis.net/gml" 
schemaLocation="http://schemas.opengis.net/gml/3.1.1/base/gml.xsd"/> 
 <xs:import namespace="http://www.cubewerx.com/cwmeta" 
schemaLocation="http://www.cubewerx.com/schemas/cwmeta/1.0.0/cwmeta.xsd"/> 
 <xs:element name="POINTS" type="cw:POINTSType" 
substitutionGroup="gml:_Feature"/> 
 <xs:complexType name="POINTSType"> 
  <xs:complexContent> 
   <xs:extension base="gml:AbstractFeatureType"> 
    <xs:sequence> 
     <xs:element name="POINTS.GEOMETRY" 
type="gml:PointPropertyType"/> 
     <xs:element name="POINTS.OSM_ID" minOccurs="0"> 
      <xs:simpleType> 
       <xs:restriction base="xs:integer"> 
        <xs:totalDigits value="10"/> 
       </xs:restriction> 
      </xs:simpleType> 
     </xs:element> 
     <xs:element name="POINTS.TIMESTAMP_" minOccurs="0"> 
      <xs:simpleType> 
       <xs:restriction base="xs:string"> 
        <xs:maxLength value="20"/> 
       </xs:restriction> 
      </xs:simpleType> 
     </xs:element> 
     <xs:element name="POINTS.NAME" minOccurs="0"> 
      <xs:simpleType> 
       <xs:restriction base="xs:string"> 
        <xs:maxLength value="48"/> 
       </xs:restriction> 
      </xs:simpleType> 
     </xs:element> 
     <xs:element name="POINTS.TYPE_" minOccurs="0"> 
      <xs:simpleType> 
       <xs:restriction base="xs:string"> 
        <xs:maxLength value="16"/> 
       </xs:restriction> 
      </xs:simpleType> 
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     </xs:element> 
    </xs:sequence> 
   </xs:extension> 
  </xs:complexContent> 
 </xs:complexType> 
</xs:schema> 
 
We can also get the current content of the Features of this feature type by doing: 
http://portal.cubewerx.com/cubewerx/cubeserv/cubeserv.cgi?CONFIG=haiti_vgi&DAT
ASTORE=vgi&service=WFS&version=1.1.0&request=GetFeature&TypeName=cw:PO
INTS.  

 
 
A particular point looks like: 
 <gml:featureMember> 
  <POINTS gml:id="CWFID.POINTS.0.0.61CB7559D106A1BE1F20020000"> 
   <POINTS.GEOMETRY> 
    <gml:Point srsName="EPSG:4326"> 
     <gml:pos>-74.1659157 18.2752643</gml:pos> 
    </gml:Point> 
   </POINTS.GEOMETRY> 
   <POINTS.OSM_ID>616162720</POINTS.OSM_ID> 
   <POINTS.TIMESTAMP_>2010-01-
18T11:43:29Z</POINTS.TIMESTAMP_> 
   <POINTS.NAME>2010-01-18T11:43:29Z</POINTS.NAME> 
   <POINTS.TYPE_>place_of_worship</POINTS.TYPE_> 
  </POINTS> 
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 </gml:featureMember> 
 
Note that this particular server is not honoring the OGC axis ordering policy, so we 
have to order the coordinates in longitude-latitude ordering. 
 
Now we have enough information to prepare a new point to be inserted in the server. 
We are going to insert "Barcelona" in the data because it will be clearly visible as a 
point far away from Haiti. We have to prepare an XML file that looks like the feature 
collection we have just downloaded but with different headers: 
 
<?xml version="1.0" encoding="UTF-8"?> 
<wfs:Transaction version="1.1.0" service="WFS" 
xmlns="http://www.cubewerx.com/cw" xmlns:wfs="http://www.opengis.net/wfs" 
xmlns:gml="http://www.opengis.net/gml" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://www.cubewerx.com/cw 
http://portal.cubewerx.com/cubewerx/cubeserv/cubeserv.cgi?CONFIG=haiti_vgi&amp;
DATASTORE=vgi&amp;service=WFS&amp;version=1.1.0&amp;request=DescribeFe
atureType&amp;outputFormat=GML3&amp;typeName=POINTS  
http://www.opengis.net/wfs http://schemas.opengis.net/wfs/1.1.0/wfs.xsd 
http://www.opengis.net/gml http://schemas.opengis.net/gml/3.1.1/base/feature.xsd"> 
 <wfs:Insert idgen="GenerateNew"> 
  <POINTS gml:id="Catalonia"> 
   <POINTS.GEOMETRY> 
    <gml:Point srsName="EPSG:4326"> 
     <gml:pos>2.17 41.39</gml:pos> 
    </gml:Point> 
   </POINTS.GEOMETRY> 
   <POINTS.OSM_ID>1111</POINTS.OSM_ID> 
   <POINTS.TIMESTAMP_>2011-08-
14T11:00:00Z</POINTS.TIMESTAMP_> 
   <POINTS.NAME>Barcelona</POINTS.NAME> 
   <POINTS.TYPE_>Non Haiti place</POINTS.TYPE_> 
  </POINTS> 
 </wfs:Insert> 
</wfs:Transaction> 
 
Let's save this file as insert.xml. To transfer an XML to a server without a specifically 
developed WFS-T client application, can be done by using the gnu wget application 
(http://gnuwin32.sourceforge.net/packages/wget.htm). The wget application has an 
optional parameter "--post-file=file_name" that allows us to send some file to the 
service as a POST method. We have also to specify --header="Content-Type:text/xml to 
report that we are transferring an xml file. This is the complete syntax: 
wget -O insert_response.xml --post-
file="insert_request.xml" --header="Content-Type:text/xml 
http://portal.cubewerx.com/cubewerx/cubeserv/cubeserv.cgi?C
ONFIG=haiti_vgi&DATASTORE=vgi 
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2.2.5.2. Insert transaction response. 
To a correct transaction request the service will answer with a transaction report. The 
previous example report is: 
 
<wfs:TransactionResponse xmlns:wfs="http://www.opengis.net/wfs" 
xmlns:ogc="http://www.opengis.net/ogc" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://www.opengis.net/wfs 
http://schemas.opengis.net/wfs/1.1.0/wfs.xsd http://www.opengis.net/ogc 
http://schemas.opengis.net/filter/1.1.0/filter.xsd" version="1.1.0"> 
 <wfs:TransactionSummary> 
  <wfs:totalInserted>1</wfs:totalInserted> 
  <wfs:totalUpdated>0</wfs:totalUpdated> 
  <wfs:totalDeleted>0</wfs:totalDeleted> 
 </wfs:TransactionSummary> 
 <wfs:InsertResults> 
  <wfs:Feature handle="Action #1"> 
   <ogc:FeatureId 
fid="CWFID.POINTS.0.1454.C546D1DB448763701F20020000"/> 
  </wfs:Feature> 
 </wfs:InsertResults> 
</wfs:TransactionResponse> 
 
As you can see, we have inserted a new object that has received a new gml:id because 
we requested that by indicating: idgen="GenerateNew". 
 
We can get the features of the cw:POINTS feature type again: 
http://portal.cubewerx.com/cubewerx/cubeserv/cubeserv.cgi?CONFIG=haiti_vgi&DAT
ASTORE=vgi&service=WFS&version=1.1.0&request=GetFeature&TypeName=cw:PO
INTS and we get: 
 



 
 
Where you can see our new feature as the last one: 
 <gml:featureMember> 
  <POINTS 
gml:id="CWFID.POINTS.0.1454.C546D1DB448763701F20020000"> 
   <POINTS.GEOMETRY> 
    <gml:Point srsName="EPSG:4326"> 
     <gml:pos>2.17 41.39</gml:pos> 
    </gml:Point> 
   </POINTS.GEOMETRY> 
   <POINTS.OSM_ID>1111</POINTS.OSM_ID> 
   <POINTS.TIMESTAMP_>2011-08-
14T11:00:00Z</POINTS.TIMESTAMP_> 
   <POINTS.NAME>Barcelona</POINTS.NAME> 
   <POINTS.TYPE_>Non Haiti place</POINTS.TYPE_> 
  </POINTS> 
 </gml:featureMember> 

2.2.5.3 Implementing an Update Transaction: Required Parameters 
 
We are going to update the OSM_ID that we have introduced in our previous example. 
We have to prepare a transaction file with a point for updating it in the server. The file 
looks similar to the previous one but with some modifications: 
 
<wfs:Transaction version="1.1.0" service="WFS" 
xmlns="http://www.cubewerx.com/cw" xmlns:wfs="http://www.opengis.net/wfs" 
xmlns:gml="http://www.opengis.net/gml" xmlns:ogc="http://www.opengis.net/ogc" 
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xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://www.cubewerx.com/cw 
http://portal.cubewerx.com/cubewerx/cubeserv/cubeserv.cgi?CONFIG=haiti_vgi&amp;
DATASTORE=vgi&amp;service=WFS&amp;version=1.1.0&amp;request=DescribeFe
atureType&amp;outputFormat=GML3&amp;typeName=POINTS  
http://www.opengis.net/wfs http://schemas.opengis.net/wfs/1.1.0/wfs.xsd 
http://www.opengis.net/gml http://schemas.opengis.net/gml/3.1.1/base/feature.xsd"> 
 <wfs:Update typeName="cw:POINTS"> 
  <wfs:Property> 
   <wfs:Name>cw:POINTS.OSM_ID</wfs:Name> 
   <wfs:Value>9999</wfs:Value> 
  </wfs:Property> 
  <ogc:Filter> 
   <ogc:FeatureId 
fid="CWFID.POINTS.0.1454.C546D1DB448763701F20020000"/> 
  </ogc:Filter> 
 </wfs:Update> 
</wfs:Transaction> 
 
Let's save this file as update.xml and transfer the file to the server again: 
wget -O update_response.x 
ml --post-file="update_request.xml" --header="Content-
Type:text/xml" "http://portal.cubew 
erx.com/cubewerx/cubeserv/cubeserv.cgi?CONFIG=haiti_vgi&DAT
ASTORE=vgi" 

2.2.5.4. Update transaction response. 
To a correct transaction request the service will answer with a transaction report. In our 
previous example the report is: 
 
<wfs:TransactionResponse xmlns:wfs="http://www.opengis.net/wfs" 
xmlns:ogc="http://www.opengis.net/ogc" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://www.opengis.net/wfs 
http://schemas.opengis.net/wfs/1.1.0/wfs.xsd http://www.opengis.net/ogc 
http://schemas.opengis.net/filter/1.1.0/filter.xsd" version="1.1.0"> 
 <wfs:TransactionSummary> 
  <wfs:totalInserted>0</wfs:totalInserted> 
  <wfs:totalUpdated>1</wfs:totalUpdated> 
  <wfs:totalDeleted>0</wfs:totalDeleted> 
 </wfs:TransactionSummary> 
 <wfs:InsertResults/> 
</wfs:TransactionResponse> 
 
We can get the features of the cw:POINTS feature type again and see our updated 
feature as the last one: 
 <gml:featureMember> 
  <POINTS 
gml:id="CWFID.POINTS.0.1454.C546D1DB448763701F20020000"> 
   <POINTS.GEOMETRY> 



    <gml:Point srsName="EPSG:4326"> 
     <gml:pos>2.17 41.39</gml:pos> 
    </gml:Point> 
   </POINTS.GEOMETRY> 
   <POINTS.OSM_ID>9999</POINTS.OSM_ID> 
   <POINTS.TIMESTAMP_>2011-08-
14T11:00:00Z</POINTS.TIMESTAMP_> 
   <POINTS.NAME>Barcelona</POINTS.NAME> 
   <POINTS.TYPE_>Non Haiti place</POINTS.TYPE_> 
  </POINTS> 
 </gml:featureMember> 

2.2.5.5 Implementing a Delete Transaction: Required Parameters 
 
We are going to delete the feature we introduced in our previous example to leave the 
dataset clean again. We have to prepare a transaction file with a point for updating it in 
the server. Te file looks similar to the previous one but with some modifications: 
 
<wfs:Transaction version="1.1.0" service="WFS" 
xmlns="http://www.cubewerx.com/cw" xmlns:wfs="http://www.opengis.net/wfs" 
xmlns:gml="http://www.opengis.net/gml" xmlns:ogc="http://www.opengis.net/ogc" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
xsi:schemaLocation="http://www.cubewerx.com/cw 
http://portal.cubewerx.com/cubewerx/cubeserv/cubeserv.cgi?CONFIG=haiti_vgi&amp;
DATASTORE=vgi&amp;service=WFS&amp;version=1.1.0&amp;request=DescribeFe
atureType&amp;outputFormat=GML3&amp;typeName=POINTS  
http://www.opengis.net/wfs http://schemas.opengis.net/wfs/1.1.0/wfs.xsd 
http://www.opengis.net/gml http://schemas.opengis.net/gml/3.1.1/base/feature.xsd"> 
 <wfs:Delete typeName="cw:POINTS"> 
  <ogc:Filter> 
   <ogc:FeatureId fid=" 
CWFID.POINTS.0.1454.C546D1DB448763701F20020000"/> 
  </ogc:Filter> 
 </wfs:Delete> 
</wfs:Transaction> 
 
Let's save this file as update.xml and transfer the file to the server again: 
wget -O delete_response.x 
ml --post-file="delete_request.xml" --header="Content-
Type:text/xml" "http://portal.cubew 
erx.com/cubewerx/cubeserv/cubeserv.cgi?CONFIG=haiti_vgi&DAT
ASTORE=vgi" 

2.2.5.6. Delete transaction response 
To a correct transaction request the service will answer with a transaction report. In our 
previous example the report is: 
 
<wfs:TransactionResponse xmlns:wfs="http://www.opengis.net/wfs" 
xmlns:ogc="http://www.opengis.net/ogc" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
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xsi:schemaLocation="http://www.opengis.net/wfs 
http://schemas.opengis.net/wfs/1.1.0/wfs.xsd http://www.opengis.net/ogc 
http://schemas.opengis.net/filter/1.1.0/filter.xsd" version="1.1.0"> 
 <wfs:TransactionSummary> 
  <wfs:totalInserted>0</wfs:totalInserted> 
  <wfs:totalUpdated>0</wfs:totalUpdated> 
  <wfs:totalDeleted>1</wfs:totalDeleted> 
 </wfs:TransactionSummary> 
 <wfs:InsertResults/> 
</wfs:TransactionResponse> 
 

2.2.6 Locking WFS Service Interface. Decentralized updating 
features 
A locking WFS server shall implement the Transactional WFS operations and shall 
implement at least one of the GetFeatureWithLock or LockFeature operations.  
 
In a distributed environment, a client that has downloaded a dataset form a server has no 
way to guarantee that while the feature was being modified on the client side, no other 
client was updateing that same feature in the database. 
A way to avoid concurrent editions is to require that access to data has to be done in a 
mutually exclusive manner; which means that while one transaction accesses a data 
item, no other transaction can modify the same data item. This can be accomplished by 
using locks that control access to the data with LockFeature and GetFeatureWithLock 
and using the received LockId in the Transaction operation. 
 

2.3 Reference to associated videos, books, and other 
resources, when available  

2.3.1 How to find WFS services in the CSR 
The page https://geossregistries.info/geosspub/geoss_search_ns.htm of the CSR allows 
you to find services that use WFS. You have to choose to look for services and then 
choose the appropriate "Referenced Classification Information Standard or Special 
Arrangement (Single Choice)". In this taxonomy you have to look for "Data access" and 
look for Web Feature Service standard. Once selected, you can press select and then 
search. At least there are 2 standards registered (1.0 and 1.1) but you can only select one 
of them for each search. 
 



 
 
Unfortunately, many people do not register the standards associated to a particular 
service and thus, you will not find them by using the procedure just explained. Instead, 
by simply searching for the word "WFS" in the name of the service, extra WFS services 
can be discover that were not carefully registered. 

3 Use Cases 

3.1 Use Case: Offering a DXF file with mapserver WFS  

3.1.1 Introduction of use case 
MapServer is an Open Source geographic data rendering engine written in C. Beyond 
browsing GIS data, MapServer allows you create “geographic image maps”, that is, 
maps that can direct users to content.  
MapServer is a popular Open Source project whose purpose is to display dynamic 
spatial maps over the Internet.  
Some of its major features include: 



• support for display and querying of hundreds of raster, vector, and database 
formats 
• ability to run on various operating systems (Windows, Linux, Mac OS X, etc.) 
• support for popular scripting languages and development environments (PHP, 
Python, Perl, Ruby, Java, .NET) 
• on-the-fly projections 
• high quality rendering 
• fully customizable application output 
• many ready-to-use Open Source application environments 

In its most basic form, MapServer is a CGI program that sits inactive on your Web 
server. When a request is sent to MapServer, it uses information passed in the request 
URL and the Mapfile to create an image of the requested map. The request may also 
return images for legends, scale bars, reference maps, and values passed as CGI 
variables. 
MapServer was originally developed by the University of Minnesota (UMN) ForNet 
project in cooperation with NASA, and the Minnesota Department of Natural Resources 
(MNDNR). Later it was hosted by the TerraSIP project, a NASA sponsored project 
between the UMN and a consortium of land management interests. 
MapServer is now a project of OSGeo, and is maintained by a growing number of 
developers (nearing 20) from around the world. It is supported by a diverse group of 
organizations that fund enhancements and maintenance, and administered within 
OSGeo by the MapServer Project Steering Committee made up of developers and other 
contributors. 
 
More information can be found at http://mapserver.org/MapServer.pdf 
Firstly, we are going to describe the installation of mapserver by using two different 
installers. And later, we are going to illustrate how to offer a DXF file. 

3.1.2 Description of use case 
A DXF, or Drawing Exchange Format, is an open sourced CAD data file format. It was 
developed by Autodesk in 1982 to enable data interoperability of 2D and 3D drawings 
between AutoCAD and other programs. Ever since, it has been updated several times, 
and the latest version (Release 14) supports both ASCII and binary forms. Files created 
with the earlier versions can also be opened with the later releases. 
In this particular case we are going to illustrate in detail on how to publish vector data in 
DXF format on Mapserver. In particular, our example is going to combine (2D) vector 
data (points and polygons) from position.  

3.1.3 Pointer from parts of use case to tutorial sections 
 

3.1.4 Example used to showcase use case 
All data used was originally from WFS servers registered and compliant with the OGC 
standards. This data is from the positions of birds, reptiles and amphibians of the 
Siberian region. (Section 4.3.1.2) 
 



3.2 User case:  Offering a data with geoserver WFS 

3.2.1 Introduction of use case 
In this tutorial we are going to describe the steps to set up the Geoserver in your 
computer. We are also going to illustrate how to offer data with Geoserver WFS, in 
particular, we are going to explain in detail how to offer shapefile data and PostGIS 
tables.  

3.2.2 Description of use case 
The characteristics of the data we are going to offer are: 
- A Shapefile, which is a collection of files (with the extensions: .shp, .dbf, .shx, .prj, 
and sometimes others). All of these files have to be in the same directory in order for 
GeoServer to accurately read them.  

- A PostGIS table, it is an open source spatial database based on PostgreSQL, and it is 
currently one of the most popular open source spatial databases today. 

In both examples we are going to create a new “Workspace” and a new “Store”. Then 
we are going to select the Vector data we want to upload, and finally all information 
about the new layer will have to be edited.  

3.2.3 Pointer from parts of use case to tutorial sections 

3.2.4 Examples used to showcase use case 
For the Shapefile, the use case is going to be illustrated by a coverage related to the 
Arctic layer. (section 4.3.2.2)  
For the PostGIS database, the example used is a map of NewYork buildings (Section 
4.3.2.3) 

3.3 User case: Offering a shapefile with deegree  

3.3.1 Introduction of use case 
To offer a shapefile with deegree, we are going to guide you on the steps to install 
deegree. These are products easily-installable packages / configurations of deegree 
components (e.g. web services) bundled for certain use-cases.  
 

After more than 5 years of ongoing development, the deegree project is the most 
extensive implementation of OGC/ISO standards in the field of Free Software. deegree 
evolved from the project JaGo and has been published under the terms of the Lesser 
GNU Public License (L-GPL) of the Free Software Foundation. Widespread 
improvements of the architecture, enhancements of the object model and the support of 
Java 5 guided to deegree to the second major release. 

In deegree2, there are OGC WebServices for Web Map Service (WMS) 1.1.1, Web 
Feature Service (WFS) 1.1.0, Web Coverage Service (WCS) 1.0.0 and Catalogue 
Service Web-Profile (CSW) 2.0.0 available. WMS and WCS are the official reference 
implementations of the Open Geospatial Consortium; WFS and CSW are fully 



transactional. CSW supports ISO19115/ISO19119 Application Profile and DE-Profile 
1.0.1.  

Furthermore, there are implementations of the OGC pre-standards of Sensor 
Observation Service (SOS), Web Terrain Service / Web Perspective and View Service 
(WTS/WPVS) as well as Web Processing Service (WPS). The security package 
contains a user and rights management system, owsProxy as a security facade of OGC 
Web Services and Web Authentication (WAS) and Web Security Service (WSS) 
definied in Spatial Data Infrastructure of NRW. 

deegree iGeoPortal standard and portlet edition are the browser-based clients for the 
mentioned OGC WebServices. deeJUMP provides a SDI-enabled Desktop-GIS. 

Besides the improvements of the architecture and the development process (e.g. 
automatic builds) the following are also important changes for users:  

• Simplified installation and configuration  
• Tool-based configuration (for WFS and WCS)  
• Support of GML 3.1 with a complex Feature Model and 3D-geometries  
• Support of PostGIS 1.0 and Oracle spatial/locator (9i/10g)  
• Advanced capabilities for object-relational mappings in the WFS  
• Multiple data sources for WMS layers  
• Dynamic rendering rules within SLD  
• High-quality and large-size print outputs through Web Map Print Service 

(WMPS)  

 

3.3.2 Description of use case 
This example is going to describe how to publish a shapefile with deegree, by 
describing the installation of the program and the packages needed. 

3.3.3 Pointer from parts of use case to tutorial sections 

3.3.4 Example used to showcase use case 
This particular use case is going to be illustrated using the example of the borders of the 
world. This is a shapefile document that has been modified to be correctly be served by 
a degree server. 
 

4 Provisioning/Using the service or application 

4.1Requirements 

4.1.1 Requirements for offering a DXF with mapserver WFS 
 
Hardware requirements: MapServer runs on Linux, Windows, Mac OS X, Solaris, and 
more. To compile or install some of the required programs, you may need 
administrative rights to the machine. People commonly ask questions about minimum 



hardware specifications for MapServer applications, but the answers are really specific 
to the individual application. For development and learning purposes, a very minimal 
machine will work fine. For deployment, you will want to investigate Optimization of 
everything from your data to server configuration. 
 
Software requirements: You need a working and properly configured Web (HTTP) 
server, such as Apache or Microsoft Internet Information 
Server, on the machine on which you are installing MapServer. OSGeo4W contains 
Apache already, but you can reconfigure things to use IIS if you need to. Alternatively, 
MS4W can be used to install MapServer on Windows. If you are on aWindows 
machine, and you don’t have a web server installed, you may want to check out MS4W, 
which will install a pre-configured web server, MapServer, and more. The FGS Linux 
Installer provides similar functionality for several Linux distributions. This introduction 
will assume you are using pre-compiled OSGeo4W Windows binaries to follow along. 
Obtaining MapServer or Linux or Mac OS X should be straightforward. Visit Download 
for installing pre-compiled MapServer builds on Mac OS X and Linux. You will also 
need aWeb browser, and a text editor (vi, emacs, notepad, homesite) to modify your 
HTML and mapfiles. 
 
In order for Mapserver to offer a DXF, the GRASS application has to be installed. 
When using the Osgeo4W installer GRASS is one of the applications that is optional to 
download. We strongly recommend using these application with mapserver when 
working with DXF images. 

4.1.2 Requirements for offering a data with geoserver WFS 

For Geoserver to run, it needs Java JDK to be installed. 

The requirements to offer a Shapefile with Geoserver are that this file .shp, needs to be 
accompanied with 3 more files, in order for the Geoserver to be alble to read it. The 
files needed are .dvf, .shp, .shx and .xml. All of them need to be stored under the same 
folder for the server to find it. 

Note: While GeoServer has robust support for the shapefile format, it is not the 
recommended format of choice in a production environment. Databases such as 
PostGIS are more suitable in production and offer better performance and scalability. 
See the section on Running in a Production Environment for more information. 
(Geoserver web page http://docs.geoserver.org/stable/en/user/data/shapefile.html). 

Shapefiles are a very common format for geospatial data. But if you are running 
GeoServer in a production environment, it is better to use a spatial database such as 
PostGIS. This is essential if doing transactions (WFS-T). Most spatial databases provide 
shapefile conversion tools. Although there are many options for spatial databases (see 
the section on Working with Data), PostGIS is recommended. Oracle, DB2, and 
ArcSDE are also supported. 

4.1.3 Requirements for offering a shapefile with degree 
The only mandatory requirement for deegree is the correct Java installation. 



4.2 Summary of Steps 

4.2.1 Summary of Steps for offering a DXF file with mapserver WFS 
When offering a DXF file with mapserver, it is recommended to download the packaged 
specified, such as GRASS, to ease the process. Next step is to define the Location in 
GRASS, which are the working folder and the project space. 

4.2.2 Summary of Steps for offering a data with geoserver WFS 
In order to offer data with Geoserver, there are common steps that need to be followed, 
and these are to start by adding a new “Workingspace”, adding a new “Store” where all 
the layers from these new project will be stored, and by “adding a new layer”. At this 
point, there is the need to define all the characteristics specific to the particular layer to 
be offered (format, coordinates, src,…). 

4.2.3 Summary of Steps for offering a shapefile with deegree 
Adding new shapefile data can be done by creating a new Feature store as “shape” type, 
and then, on the window that opens, manually edit the positions of the vector shapefiel. 
Here, the content of the <File> also have to be changed by the relative position of the 
shpafile, but without the extension .shp. Finally, change the <FeatureTypeName> for 
the new name that you want to be published in the WFS. Now you just need to reload 
the server to view the new layer. 

4.3 Detail Steps for Use Cases 

4.3.1 Offering a DXF file with mapserver WFS  

4.3.1.1. Step 1: MapServer Installation 
MapServer is an Open Source project which can be installed from several Windows 
Installers. In this tutorial we are going to describe two different installers: OSGeo4W 
and MS4W. In both cases a step by step explanation is done, while specifying 
requirements of the system and common errors during the installation. 
 
Other documentation of interest: 
• MapServer http://www.mapserver.org/  
• Introduction to MapServer: http://www.mapserver.org/introduction.html  
• Mapfile Reference: http://www.mapserver.org/mapfile/  
• Data Input in MapServer: http://www.mapserver.org/input/  
• OGC Support in MapServer: http://www.mapserver.org/ogc/  
 
A. Installation of mapserver with MS4W 
 

Download MS4W 

1. Download the version available at  

http://www.maptools.org/ms4w/index.phtml?page=downloads.html 
of the Set up exe installer: ms4w-3.0.3-setup.exe   
 



 

Installation of the MS4W 

2. To install the MS4W .zip file, use a compression program (e.g. WinZip) to extract the 
package at the root of a drive, e.g., drive C:. If successful, you should have a new 
directory named 'ms4w' at the root of the drive you chose (e.g. C:/ms4w). 

   Start your MS4W Apache Web Server by running /ms4w/apache-install.bat (at the 
command line or by double-clicking it). This file installs Apache as a Windows 
service (called "Apache Web Server") so that it starts whenever your machine is 
restarted. When executed, a DOS window should pop up with the following message: 

 
Installing the Apache MS4W Web Server service 
The Apache MS4W Web Server service is successfully installed. 
Testing httpd.conf.... 
Errors reported here must be corrected before the service 
can be started. 
The Apache MS4W Web Server service is starting. 
The Apache MS4W Web Server service was started successfully. 

 
This means that Apache is running and installed as a service. 
The window “Setup: License Agreement” will appear. Read the license agreement and 
click I Agree. 



 
 
3. An “Installation Option” windows will open. Select your installation options. 
 

 
 
After selecting your installation options click “Next”. 
4. When the “Installation Folder” opens, you must specify the location to install the 

MS4W. Usually this is set to the root directory (C:). Then click “Next”. 
 

 
 
5. Set the Apache port. The port you set doesn’t have to be already in use. If you think 

that the port 80 might be already in use then try a higher port number (above 1024) 
such as 8081. Click “Install”. 

 



 
 
 
A downloading window will show the progress of the installation. 
 

 
 

 
 

Verification 

6. There are two options to verify that the mapserver is correctly installed, one way 
would be that on the MS4W-Shell DOS window type mapserv –v. The DOS 
window should show the following message: 

 



 
 
Another way to verify if mapserver is installed is by browsing to the localhost, and then 
the following page should be seen: 
 

 
 
If you want to install more programs, they have to be downloaded into the root of the 
ms4w directory. 
 

 



 
Not that in both cases there are no addon packages installed into your localhost. If you 
want to install new applications these should be downloaded from Mapserver web page 
http://www.mapserver.org/, and save the new application to the root directory were the 
mapserver is installed, as accept to replace the files you have for the new ones. 
 
 
 
B. Installation with OSGeo4W 
 
OSGeo4W is an installer for the Windows operating system that contains several 
packages related to the Open Source Geospatial Foundation. 
 
Website: http://www.osgeo.org  
 
 
Introduction 
 
OSGeo4W is a Windows installer that downloads and/or updates MapServer, add-on 
applications, and also other Open Source geospatial software. The following steps 
illustrate how to use OSGeo4W: 

Download OSGeo4W 

1.  Download OSGeo4W  

Download OSGeo4W Installer from: 
http://download.osgeo.org/osgeo4w/osgeo4w-setup.exe 
 

2. Start the OSGeo4W Installer 

2.1 Execute (double-click) the ‘osgeo4w-setup.exe’, and a new window should open 

 
 
 



Choose an option on this new window.  
- The “Express Desktop Install” option contains options for higher-level 
packages such as MapServer, GRASS and u-Dig.  
- The “Express Web-GIS Install” option, can be a basic option 
- The “Advanced Install” gives you full access to choosing command line tools 
and applications for MapServer that are not included in the Express installation. 

Once you have one of the options installed, all other options or packages can be updated 
or downloaded afterwards. It will be explained later on this tutorial. 

 
2.2 On this new window choose the “Advanced Install” option. 
A new window will open, choose the Download Source and click “Next”. 

 
Select the root directory where the program will be installed.  
 

 
Next window that appears has it set by default by the Firefox. We change it to the 
desired one. 
 



 
 
Select your internet connection 
 

 
2.3 Select the packages to install 
 
 



 
 
 
On this page, you can click into each of the Default texts. For example, when clicking 
on the “Web Default” text, a drop-down menu will open indicating which Web’s sub-
packages are going to be installed by default. You can also click on the “skip” text 
besides the sub-package name (such as MapServer) to install a package that by default 
would not be installed. 
 

 
Note: If the Selected package option is left with the Skip text on, this will mean that the 
installation of that package will not be done. To select a package, you have to click on 
the Skip text to obtain: 



 
You can see that the size of the package vary depending on the option you set up. 
After setting up which packages you want to install, a new window opens. On the 
“Create Icons” window you have to select one or both options offered. 
 

 
 
 
2.4 Download Packages/Installation 



 
 
The installer should now automatically fetch and install MapServer and all of its 
libraries from the OSGeo download server. 
 
2.5 Finish Installation 
Once downloading and installation from the OSGeo download server is complete, you 
can now optionally choose to creat shortcuts for OSGeo4W on your desktop, and also in 
your Start Menu (both are recommended). Click the “Finish” button to finalize the 
installation. 
 

 
 
2.6 To verify that MapServer installation is working 
You can verify that MapServer is installed through several ways. 
To run the program firstly you need to open the OSGeo4W Shell that you will find on: 
 

Start/OSGeo4W/OSGeo4W Shell 
 
Or  
 
It can be also available as a shortcut in your computer 

 
Note: The fist time you try to run the OSGeo4W Shell, you may need to browse to your 
Shell in order to open it. Comprovar la manera que diu el tutorial descarregat…. 
 
Secondly, you need to run the apache-install.bat script to install the Appache Service. 
This will be ran through the OSGeo4W shell (DOS window) 



 
 
Access to the http://127.0.0.1/ 
 

 
 
Note: Be aware that if you have changed the default port number during the installation 
process you will then have to access to the http://127.0.0.1:81 
 



 
 
 
To verify that MapServer is working, go to 
http://127.0.0.1/cgi-bin/mapserv.exe . This page should appear. 

 

 
Or by opening the OSGeo4W shell and type mapserv –v  
 

 
 



 
 

4.3.1.2. Step 2: Setup a DXF file in MapService  
In order to set up a DXF file with mapserver, you first need make sure that the GRASS 
package has been installed when installing the mapserver. This can be easily done by 
accessing to the http://127.0.0.1/ (or your mapserver home page), if GRASS is installed, 
you should see it on the list of packages. Otherwise, you should go to the step 2. 
Installatiojn, and select the package on the step 2.3. 
 
Ones installed open the OSGeo4W Shell 
Run the apache-install.bat script in the OSGeo4W Shell  
 
On your “All Programs”, under the OSGeo4W it should also have a quick link to 
GRASS.  
To have more information on GRASS, please go to 
http://mirrors.ibiblio.org/grass/intro/general.php and 
http://mirrors.ibiblio.org/grass/intro/firsttime.php. 

 
 

4.3.1.3. Step 3: Test your WFS Service in clients 
Accessing the service 

1. Start uDig, under the File menu select New > New Map to create a new map. 
2. Make sure your local GeoServer is started and ready to go.  
3. Select Layer > Add 
4. This will bring up a Wizard allowing you to choose which Data source you want 

to use.. Select Web Feature Server. 

 



5. This open a window where you have to insert the URL of a web feature server 
you want to access. In our case type: http://localhost:8080/geoserver/wfs? and click 
Next. 

 
6. You have now access to all WFS layers available on our Mapserver, press the 
Finish button. The layer will be drawn on your map. 
 

4.3.1.4 Step 6: Optimizing the service performance and maintenance 
Information regarding optimization can be found in 
http://mapserver.org/optimization/vector.html 

4.3.1.5 Step 7: Service errors and troubleshooting 
Common errors can be found in http://mapserver.org/errors.html 

4.3.2 Offering a data with geoserver WFS 
We are going to illustrate in detail and step by step two cases: How to publish a single 
GeoTIFF image on your GeoServer and How to publish a GeoTIFF mosaic scene on 
your GeoServer. 
 
GeoServer can be downloaded from http://geoserver.org/display/GEOS/Download. IN 
this example we are going to use the version 2.1.1. 
 
Before starting, if you do not have the GeoServer set up as a service you need to start it 
manually. To do so, go to the Start>Programs> GeoServer2.1.1>Start GeoServer. A 
DOS window will open (and should be kept open) indicating that GeoServer has started 
and it is running. 
 
Go to the GeoServer Administration link in the Start Menu (GeoServer Web Admin 
Page) or point your web browser to http://localhost:8080/geoserver. This page is the 
Web administration interface, which is used to configure all aspects of the GeoServer, 
and add data to tweaking services settings. 
 
This documentation is directly coming from the GeoServer website 
(http://docs.geoserver.org) 
 

4.3.2.1 Case 1: How to setup GeoServer 
 
Step 1: GeoServer Installation 
 
Related documentation (for installation on Linux, Mac, or using WAR file): 
http://docs.geoserver.org/stable/en/user/installation/index.html 
 
System requirements 
GeoServer can run either on MS Windows, Linux or Mac OS X. 
Some general system requirements for the software to run without problems are listed: 
Processor: 2 GHz or higher Memory (RAM): 1 GB or higher 



Disk Space: 200 MB minimum. However, it is suggested to have a minimum of 1 GB of 
free disk space. Additional space is required depending on the amount of spatial data 
that you expect to upload. 
Other Software requirements: A Java Runtime Environment (JRE 1.5.0). For server 
installations, Apache Tomcat can be used instead of Jetty and McKoiDB respectively. 
 
1. Installation 
In order to install de GeoServer, firstly the Installation of Java Developement Kit has to 
be done 
Latest version can be found at: 
http://www.oracle.com/technetwork/java/javase/downloads/index.html  
 

 
1. Select Download Java Platform (JDK) 7 
 



 
Here you need to select your file description, that is to say which java you need 
according to your system (windows x86,…). When the option to download is selected, a 
new http page will open for you to register: 
https://hs-ws1.oracle.com/RegistrationWeb/registration/default/en_US/register-
login.jsp?legacy=true&tgtPrd=jdk&prd=registration&uuid=urn%3Ast%3Ac15685dd-
d2e0-422f-b848-7f555d27c22b&tgtVer=7  
 
2. Run the executable file you downloaded. 
3. Accept the license agreement and click “Next” 
4.  A “Custom Setup” screen will open, and then all optional features can be selected. 
5. Click “Next”. 
6. Once the Disable the Public Java Runtime Environment (JRE) 



 
When your installation is completed click “Finish”. 
Registration of your program can be done at: 
https://hs-ws1.oracle.com/RegistrationWeb/registration/default/en_US/register-
login.jsp?legacy=true&tgtPrd=jdk&prd=registration&uuid=urn%3Ast%3A666b6296-
2f85-4311-b735-7d4d80e32641&tgtVer=7 

 
Download GeoServer 

 
1. Now we are ready to download GeoServer 
Go to the download page and get the latest Stable release: 
http://geoserver.org/display/GEOS/GeoServer+2.1.1  



 
 
And download the format that best fits you. In our case this will be Windows 
Installer. It can take some time for the Download to start transferring the geoserver 
executable 

 



In our case, download the “Windows Installer”. 
 

2. Run the Installer 
1. To run the installer, double click the geoserver executable that has just been 

downloaded.   
 



 
Click into the “Next” button. 
 

 
Read the GPL license and click I Agree 

 
Choose your install location and click Next, you can leave it in the default directory 
or change it into another one you prefer. 



 
 

3. Choose the name of the Start Menu Folder and click “Next”. Usually this is left 
to its default value. 

 
4. Define the path to your JDK install directory by browsing, and click “Next”. 



 
 
 

5. The next window asks where your GeoServer Data Directory is. If this is your 
first time installing GeoServer, just leave it as Default and click “Next”. If you 
have a previous version of the GeoServer installed, and you want to use your 
existing data directory, enter the path to the existing Data Directory. Click 
“Next”. 

 
 



 
 

6. Define user name and Password for an administrator account. You can leave the 
default values (username: admin, password: geoserver) 

 
7. The next window allows you to select the port number on which GeoServer will 

run. You can leave it as it is (port: 8080). 

 
 

8. The following window request us which kind of installation are we going to do. 
In our case we are going to Run it Manually 

 
 



9. Finally, a window Ready to Install opens for you to install the GeoServer 

 
 

10. When the installation of GeoServer is completed the following window appears: 

 
 
At this point you must have Java DK installed and GeoServer Installed. The Geoserver 
should be seen as a short cut in your Start Menu. 
 
 
Step 2. Starting GeoServer 
 

1. Before starting GeoServer, the following environment variables have to be 
defined: JAVA_HOME and GEOSERVER_HOME. These are the paths to the 
JDK and GeoServer install directories.  

2.  You have to go to Start/Settings/Control panel/System, and click the 
“Advanced” tab. Then click on the “ Environment vaiables” button. 



 
 
3. Under “User Variables”, click on New and define your JAVA_HOME variable 

and then your GEOSERVER_HOME. 

 
 
 

4. Go to Start/Programs/GeoServer 2.1.1/Start GeoServer. A DOS window will 
open (and stay open) indicating that GeoServer has started. 

 



5. After starting up the program, the administrator interface should be available 
through the GeoServer Administration link in the Start Menu or by pointing 
your web browser to http://localhost:8080/geoserver/web/ 

 

For insights on the Web Administration Interface, please refer to: 
http://docs.geoserver.org/stable/en/user/webadmin/index.html 

4.3.2.2 Case 2: Offering a shapefile with geoserver WFS  
 
Step 1: Setup a Shapefile 
We are going to publish a coverage that is related to the Arctic layers that we previously 
used in the definition of the data model section. 
 
First, you have to create a new namespace: 



 
We will name it "arctic" 

 
Now, we are going to create a data store to include the arctic shape files that we have 
previously downloaded from the atlas of the cryosphere. 
 
In our case, the idea is to publish the following data: 



 
 

 
Before completing the following form, we have to copy the Shapefiles to the right 
folder. In our case, the default installation folder is called: C:\Program Files\GeoServer 
2.0.1\data_dir\data\shapefiles. Remember that you have to copy at least the *.shp. *.dbf, 
*.shx, and also the *.prj, when available. In our case, these are the files we copied: 



 
 
Now, we are able to fill the remaining fields of the form. In the Connection Parameters 
URL we introduced the full path and name of the file with .shp extension. After 
completing the form, we can click on “Save”  

 
 
The following screen will appear: 



 
 
Press publish and another form will appear to enter the CRS and the bounding boxes. 

 
 
Once you press “Save”, you will see: 



 
In theory, your data is ready to be seen in your WFS service. 
 
Step 2: Test your data 
Testing the layer in GeoServer is very simple, because it incorporates tools to do that. In 
the Layer preview section, it is possible to test the WFS service by selecting the right 
layer and choosing the right service and format: 

 
 
This way GeoServer generates a WFS request that automatically retrieves the dataset in 
GML3 format. In our case, it has generated 
http://localhost:8080/geoserver/ows?service=WFS&version=1.0.0&request=GetFeature
&typeName=arctic:cryosphere_atlas_north13126453601905475_data&maxFeatures=50
&outputFormat=text/xml; subtype=gml/3.1.1 
and we have got the whole polygon dataset as an XML file.  



 
Also, in the Gaia v.3 application we can choose tools|add layer and then select the 
button with a "plus" symbol. Now we must indicate the name of the service (you can 
provide any name) and the URL of the GeoServer (by default: 
http://localhost:8080/geoserver/ows). 

 
After pressing ok, you will be able to select the cryosphere layer and the version of 
GML to use. 



 
 
and this is the result: 



 

4.3.2.3 Case 3: Offering a PostGIS table with geoserver WFS  
Step 1: Setup a PostGIS data 
 
Create a new data store¶ 
The first step is to create a data store for the PostGIS database “nyc”. The data store 
tells GeoServer how to connect to the database. 

1. In a web browser navigate to http://localhost:8080/geoserver. 
2. Navigate to Data Stores. 

 

 
 

Adding a New Data Source 
3. Create a new data store by clicking the PostGIS link. 
4. Keeping the default Workspace enter Basic Store Info of Name and Description. 



 

 
 

Basic Store Info 
5. Specify the PostGIS database Connection Parameters 
Option Description 
Workspace Name of the workspace to contain the database. This 

will also be the prefix of any layer names created from 
tables in the database. 

Data Source Name Name of the database. This can be different from the 
name as known to PostgreSQL/PostGIS. 

Description Description of the database/store. 
Enabled Enables the store. If disabled, no data in the database 

will be served. 
dbtype Type of database. Leave this value as the default. 
host Host name where the database exists. 
port Port number to connect to the above host. 
database Name of the database as known on the host. 
schema Schema in the above database. 
user User name to connect to the database. 
passwd Password associated with the above user. 
namespace Namespace to be associated with the database. This 

field is altered by changing the workspace name. 
max connections Maximum amount of open connections to the database. 
min connections Minimum number of pooled connections. 
fetch size Number of records read with each interaction with the 

database. 
Connection timeout Time (in seconds) the connection pool will wait before 

timing out. 
validate connections Checks the connection is alive before using it. 
Loose bbox Performs only the primary filter on the bounding box. 

See the section on Using loose bounding box for details. 
preparedStatements Enables prepared statements. 
 
6. Note The username and password parameters specific to the user who created 

the postgis database. Depending on how PostgreSQL is configured the password 
parameter may be unnecessary.  



  
 

Connection Parameters 
7. Click the Save button 
 
Layer Configuration¶ 
1. Navigate to Data‣Layers. 
2. Select Add a new resource button. 
3. From the New Layer chooser drop down menu, select cite:nyc_buidings. 

 

 
 



New Layer drop down selection 
On the resulting layer row, select the Layer name nyc_buildings. 
 

 
 
New Layer row 
4. The following configurations define the data and publishing parameters for a 

layer. Enter the Basic Resource Info for nyc_buildings.   
 

  
 

Basic Resource Info 
5. Generate the database bounds by clicking the Compute from data and then 

Compute from Native bounds.  
 

  
Generate Bounding Box 
6. Set the layer’s style by first moving over to the Publishing tab. 
7. Then select polygon from the Default Style drop down list. 



 
 
Select Default Style 
8. Finalize your data and publishing configuration by scrolling to the bottom and 

clicking Save. 
Preview the Layer¶ 
9. In order to verify that the nyc_building is published we will preview the layer. 

Navigate to the Map Preview and search for the cite:nyc_buildings  

 
 Layer Preview 
10. Click on the OpenLayers link under the Common Formats column. 
 
Success! An OpenLayers map should load with the default polygon style. 

 



OpenLayers map of nyc_buildings 
 
Step 2: Test your WFS Service in clients 
 
You can test WFS service in various clients. In our case we will show how to access a 
WFS Service in uDig (http://udig.refractions.net) 
 
We asume that uDig is installed on the computer. 
 
Getting started 

1. After completing the installation, run the uDig application from the Windows 
Start > Programs menu. 

 
2. Initially you are presented with the welcome screen. 
3. The welcome screen contains a link to the Getting Started tutorial from the 

online documentation and a link to the Official Website. 



 
4. To continue click on the Workbench arrow in the top right corner of the uDig 

welcome screen. 
5. You are now ready to start to work with uDig. 



Start uDig, under the File menu select New > New Map to create a new map. 
Make sure your local GeoServer is started and ready to go.  
Select Layer > Add 
This will bring up a Wizard allowing you to choose which Data source you want to use.. 
Select Web Feature Server. 



 
This open a window where you have to insert the URL of a web feature server you want 
to access. In our case type: http://localhost:8080/geoserver/wfs? and click Next. 

 
You have now access to all WFS layers available on our GeoServer. Select Manhattan 
(NY) landmarks and the press the Finish button. The layer will be drawn on your map. 



 
Accessing the service 

7. Start uDig, under the File menu select New > New Map to create a new map. 
8. Make sure your local GeoServer is started and ready to go.  
9. Select Layer > Add 
10. This will bring up a Wizard allowing you to choose which Data source you want 

to use. Select Web Feature Server. 

 



11. This open a window where you have to insert the URL of a web feature server 
you want to access. In our case type: http://localhost:8080/geoserver/wfs? and 
click Next. 

 
12. You have now access to all WFS layers available on our GeoServer. Select 

Manhattan (NY) landmarks and the press the Finish button. The layer will be 
drawn on your map. 



 

4.3.2.4 Step 6: Updating data 
In Step 3 we have accessed a WFS layer. Now we can show the editing (transactional) 
capabilities of a WFS service. 

1. Select Navigation > Show All from the menu bar. 
11. Zoom to a specific buffer 
12. Select Manhattan (NY) landmarks in the Layers view. 
13. Choose to the Edit Geometry tool from the tool bar 

 
14. Use the Edit Geometry tool to select a buffer. The buffer will change color and 

develop “vertex handles”. 
15.  Move the vertex handles as you want. 
16.  Once finished, press the Commit Changes button in the tool bar to send your 

changes off to the Web Feature Server. 

 
 Your changes have been registered. 

4.3.2.5 Step 7: Optimizing the service performance and maintenance 
To optimize service performance various considerations must be taken into account. 
An interesting paper discuss these issues: http://opengeo.org/publications/geoserver-
production/ 
 
Java consideration 
 http://docs.geoserver.org/stable/en/user/production/java.html  



Container consideration 
 http://docs.geoserver.org/stable/en/user/production/container.html 
Configuration consideration 
 http://docs.geoserver.org/stable/en/user/production/config.html 
Data considerations 
 http://docs.geoserver.org/stable/en/user/production/data.html 
Other 
 http://docs.geoserver.org/stable/en/user/production/misc.html 

4.3.2.6 Step 8: Service errors and troubleshooting 
Please refer to: http://docs.geoserver.org/stable/en/user/production/troubleshooting.html 

4.3.2.7 Step 9: Register the service with GEOSS 
This step is related to the CSR tutorial -> make a link to it. 

4.3.3 Offering a shapefile with deegree 
Deegree version 3.0 offers the possibility to have a WMS and WFS service 
simultaneously with a single application. It also provides WPS and CSW support. The 
easiest way to start with Deegree is setting up the demo version that includes Utah 
datasets. This version is the one we are going to use. 
 
Before setting up degree, you must setup the JDK java virtual machine. Please do not 
rely on the usual JRE because it will not work. We have downloaded the version jdk-
7u1-windows-i586.exe from the Oracle website http://www.oracle.com/index.html 

 
Once the Java setup is completed, it is important to define the JAVA_HOME path. This 
is done by including a new environment variable in the system by creating it in the 
advanced tab of the system properties. 



 
 
You can know download Deegree 3.0. We have done it directly from 
http://download.deegree.org/deegree3/deegree-utah-demo-3.0.4.zip and decompressed 
the zip file to the c: root directory. The decompression creates the following folder. 

 
 
Now you can open a Windows console (CMD), change directory to 
"c:\deegree_utah_demo" and run "start-deegree.bat". The result is another console 
window with a tomcat report about the web service starting process. Leave this window 
open, unless you want to close the service. 



 
 
Now Deegree is running in your machine under the port 8080, and you can get access to 
the main interface just by typing http://localhost:8080 in a web browser: 

 
 
Now, you have to click on "download" to get the data that is needed to run this demo: 

 
 
After the download is completed, new options will appear in the same screen. Among 
the new ones, you will see "administrative console" that allows you to configure your 
server and to add new data: 



 
To get in, you need to know the default password: "deegree". 
 
Step 1: Adding new data 
 
At this point, we are going to create a new feature store with the name "world_borders", 
which is a "Shape" type. 

 
 
The system creates a new configuration file for this layer. We have to manually edit the 
position of the vector shape file that we are going to publish. We have downloaded a 
world borders dataset from: 
http://thematicmapping.org/downloads/TM_WORLD_BORDERS_SIMPL-0.3.zip. To 
simplify the process we are going to decompress the data directly into the same 



directory where the Utah data is: C:\deegree-utah-demo\webapps\ROOT\WEB-
INF\workspace\data\data\utah\vector.  
In the next screen, we have to change the content of the <file> element to include the 
relative position of the shp file using '/' as slashes (instead of back slashes) and without 
the extension ".shp". We also have to change the <FeatureTypeName> to a data type 
name that will be representative in the wfs capabilities. In our case we introduced 
"WorldBorders" instead of the proposed "Shape". 

 
Once you save it, you have to reload the server by pressing a small red linked text. 

 
 
Finally, the layer becomes available at the end of the list below the others. 
 

 
 
 
 



Step 2: Testing the layer 
The first evidence that the system is working properly is that we can see the layer in the 
capabilities document. Accessing the capabilities document is as simple as clicking in 
the text "Capabilities" from in the "web services" subpage, next to "On wfs Edit": 

 
 
The capabilities document includes the name of the layer that we have just included: 

 
 
Once again, we use Gaia v3 to illustrate that the resulting dataset works perfectly. Gaia 
can be downloaded from: http://www.thecarbonproject.com/gaia.php and requires 
Microsoft NET framework 2.0 to start. 
 
When the program is started, the only thing we have to do is to press the icon with the 
plus symbol from the dark blue bar, and add a new server by clicking again in the 
multilayer with a plus symbol icon. In our installation, the name of the service is 
http://localhost:8080/services but, in a real implementation, we are going to use the ip 
name of the machine instead of “localhost”. 



 
After an arbitrary "name" is introduced and the "version" 1.1.0 is selected, we can click 
“OK” to select the relevant layer that, in this particular case is app:WorldBorders. If you 
are doing itcorrectly, you will see a preview of the layer: 



 
Since this is a WFS service, the elements are individualized and we can select one of 
them to find the attributes. 

 
This illustration shows world vector map and the result of a query by location for Libya. 
 
 
4.3.4 Setting up a community updated layer with WFS-T cubewebx 



The section 2.2.5 Transactional WFS Service Interface. Updating features describes 
how a transactional WFS can be used. The example uses a demonstrative dedicated 
portal provided by Cubewerx during the Haiti earthquake that is still operational at the 
URL 
http://portal.cubewerx.com/cubewerx/cubeserv/cubeserv.cgi?CONFIG=haiti_vgi&DAT
ASTORE=vgi). Please refer to that section for details 
 

Apendix A Troubleshooting 
Old GML files can point to and old schema repository such as: 
http://schemas.opengeospatial.net/gml/2.1.2/feature.xsd. The new OGC schema 
repository is http://schemas.opengis.net/gml/2.1.2.1/feature.xsd 
 
ShapeChange "No application schema found" error. 

Appendix B  FAQ 

Appendix C  Glossary/Acronyms 
For the purposes of this document, the following terms and definitions have been taken 
from the OpenGIS Web Feature Service 2.0 Interface Standard, Open Geospatial 
Consortium Inc.  
 
attribute <XML>  
name-value pair contained in an element (4.6)  
[ISO 19136:2007, definition 4.1.3]  
NOTE In this document an attribute is an XML attribute unless otherwise specified.  
 
client  
software component that can invoke an operation (4.17) from a server (4.28)  
[ISO 19128:2005, definition 4.1]  
 
coordinate  
one of a sequence of n numbers designating the position of a point in n-dimensional  
 
space  
[ISO 19111:2007, definition 4.5]  
 
coordinate reference system  
coordinate system (4.5) that is related to an object by a datum  
[ISO 19111:2007, definition 4.8]  
 
coordinate system  
set of mathematical rules for specifying how coordinates (4.3) are to be assigned to 
points  
[ISO 19111:2007, definition 4.10]  
 
element <XML>  
basic information item of an XML document containing child elements, attributes (4.1) 
and character data  



[ISO 19136:2007, definition 4.1.23]  
 
feature  
abstraction of real world phenomena  
[ISO 19101:2002, definition 4.11]  
NOTE A feature can occur as a type or an instance. The term "feature type" or "feature 
instance" should be used when only one is meant.  
 
feature identifier  
identifier that uniquely designates a feature (4.7) instance OGC 09-025r1 and ISO/DIS 
19142   
 
filter expression  
predicate expression encoded using XML  
[ISO 19143, definition 4.11]  
 
interface  
named set of operations (4.17) that characterize the behaviour of an entity  
[ISO 19119:2005, definition 4.2]  
join predicate  
filter expression (4.9) that includes one or more clauses that constrain properties from 
two different entity types  
[ISO 19143, definition 4.16]  
NOTE In this International Standard, the entity types will be feature (4.7) types.  
 
join tuple  
set of two or more object instances that satisfy a filter that includes join predicates 
(4.11)  
NOTE In this International Standard, the object instances will be feature (4.7) instances.  
 
local resource  
resource that is under the direct control of a system  
NOTE In this International Standard, the system is a web feature service and the 
resource is held in a data store that is directly controlled by that service.  
 
locator attribute  
attribute (4.1) whose values is a reference to a local resource (4.13) or remote resource 
(4.20)  
NOTE In XML, this attribute is commonly called an href and contains a URI reference 
to the remote resource (see W3C XLink).  
 
Multipurpose Internet Mail Extensions (MIME) type  
media type and subtype of data in the body of a message that designates the native 
representation (canonical form) of such data  
[IETF RFC 2045:1996]  
 
namespace <XML>  
collection of names, identified by a URI reference which are used in XML documents 
as element (4.6) names and attribute (4.1) names  
[W3C XML Namespaces:1999]  



 
operation  
specification of a transformation or query that an object may be called to execute  
[ISO 19119:2005, definition 4.3] OGC 09-025r1 and ISO/DIS 19142 6 Copyright © 
2010 Open Geospatial Consortium  
 
property  
facet or attribute of an object, referenced by a name  
[ISO 19143:2010, definition 4.21]  
 
resource  
asset or means that fulfils a requirement  
[ISO 19143, definition 4.23]  
NOTE In this International Standard, the resource is a feature (4.7), or any identifiable 
component of a feature (e.g. a property of a feature)  
 
remote resource  
resource that is not under direct control of a system  
NOTE In this International Standard, the system is a web feature service. The resource 
is not held in any data store that is directly controlled by that service and thus cannot be 
directly retrieved by the service.  
 
request  
invocation of an operation (4.17) by a client (4.2)  
[ISO 19128:2005, definition 4.10]  
 
relocate  
<reference> update a reference to a resource that has been moved or copied to a new  
location  
EXAMPLE A server (4.28) is generating a response (4.24) to a GetFeature request 
(4.21), it has to copy a referenced feature (4.7) into the response document and the 
server has to "relocate" the original link contained in the referencing feature to the copy 
placed in the response document.  
 
resolve  
retrieval of a referenced resource and its insertion into a server-generated response 
document  
NOTE The insertion may be accomplished by either replacing the reference in-line with 
a copy of the resource or by relocating the reference to point to a copy of the resource 
that has been placed in the response document.  
 
response  
result of an operation (4.17) returned from a server (4.28) to a client (4.2)  
[ISO 19128:2005, definition 4.11]  
 
response model  
schema (4.26) defining the properties of each feature (4.7) type that can appear in the 
response (4.24) to a query operation (4.17)  
NOTE This is the schema of feature types that a client (4.2) can obtain using the 
DescribeFeatureType operation (see Clause 9).  



 
schema  
formal description of a model OGC 09-025r1 and ISO/DIS 19142   
[ISO 19101:2002, definition 4.25]  
NOTE In general, a schema is an abstract representation of an object's characteristics 
and relations to other objects. An XML schema represents the relationship between the 
attributes (4.1) and elements (4.6) of an XML object (for example, a document or a 
portion of a document). 
  
schema <XML Schema>  
collection of schema (4.26) components within the same target namespace (4.16)  
[ISO 19136:2007, definition 4.1.54]  
EXAMPLE Schema components of W3C XML Schema are types, elements (4.16), 
attributes (4.1), groups, etc.  
 
server  
particular instance of a service (4.29)  
[ISO 19128:2005, definition 4.12]  
service  
distinct part of the functionality that is provided by an entity through interfaces (4.10)  
[ISO 19119:2005, definition 4.1]  
 
service metadata  
metadata describing the operations (4.17) and geographic information available at a 
server (4.28)  
[ISO 19128:2005, definition 4.14]  
 
traversal  
<XML>  
using or following an XLink link for any purpose  
[W3C XLink:2001]  
 
tuple  
ordered list of values  
[ISO 19136:2007, definition 4.1.63]  
NOTE In this International Standard, the order list will generally be a finite sequence 
for features (4.7), each of a specific feature type.  
 
Uniform Resource Identifier  
unique identifier for a resource, structured in conformance with IETF RFC 2396  
[ISO 19136:2007, definition 4.1.65]  
NOTE The general syntax is <scheme>::<scheme-specified-part>. The hierarchical 
syntax with a namespace (4.16) is <scheme>://<authority><path>?<query> OGC 09-
025r1 and ISO/DIS 19142 
 
Abbreviated terms  
 
CEOP Critical Earth Observation Priorities  

CEOS Committee on Earth Observation Satellites 

CGI Common Gateway Interface  



CIM Core ISO Metadata 

CRS Coordinate Reference System  

CSR Components and Services Registry 

DCP Distributed Computing Platform  

DCP Distributes Computer Platforms 

DSTF Data Sharing Task Force  

DTD Document Type Definition 

EO Earth Observation 

EOP Earth Observation Product 

EPSG European Petroleum Survey Group  

FES Filter Encoding Specification 

GCI CT GEOSS Common Infrastructure Coordination Team 

GEO Group on Earth Observations 

GEOSS Global Earth Observing System of Systems 

GIGAS Project Global Earth Observing System of Systems 

GML Geography Markup Language  

HTTP Hypertext Transfer Protocol  

HTTPS Secure Hypertext Transfer Protocol  

ILAF OGC 

ISO International Organisation for Standardisation 

IETF Internet Engineering Task Force  

KVP Keyword-value pairs  

MIME Multipurpose Internet Mail Extensions  

OGC Open Geospatial Consortium  

OWS OGC Web Service  

PSC The MapServer Project Steering Committee 

RPC Remote Procedure Call  

REST Representational State Transfer  

SDI Spatial Data Infrastructure (1990's) 

SIF Standards and Interoperability Forum 

SQL Structured Query Language  

SOAP Simple Object Access Protocol  

UML Unified Modelling Language  

URI Uniform Resource Identifier  

URL Uniform Resource Locator  



URN Uniform Resource Name  

VSP Vendor Specific Parameter  

WFS Web Feature Service  

WMS Web Map Service 

WCS Web Coverage Service 

WSDL Web Services Description Language  

W3C World Wide Web Consortium 

XML Extensible Markup Language 

Web Aliases Web-accessible directories  
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